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FOREWORD

The Punjab Curriculum Framework (PCF 2013) which is based on National
Curriculum Framework (NCF) 2005 recommends that the child's knowledge must be
connected to their life outside the school. It indicates a departure from the legacy of
bookish learning and ensures that learning is shifted from rote methods to activity based

learning and also provides an opportunity for the holistic development of the students.

Over the years, Computer Science as a discipline has evolved and emerged as a
driving force for socio-economic activities. Computer technologies are widely used in
diverse areas of modern life such as education, business, health, transport and all other
sectors also. With the advent of computer and communication technologies, there has
been a paradigm shift in teaching at the school level. The role and relevance of this
discipline is in focus because the expectations from the school pass-outs have grown to
meet the challenges of the contemporary world. Today, we are living in an
interconnected world where computer-based applications influence the way we learn,

communicate, commute or even socialise in day to day life.

Keeping in view these requirements, Punjab School Education Board has
introduced Computer Science as a compulsory subject from class 6th to 12th as per
guidelines of Punjab Government. Every effort has been made to include each requisite
information according to level of class 8th in this book. I hope it will be useful for

students and teachers.

This book focuses on the fundamental concepts and problem-solving skills
while opening a window to the emerging and advanced areas of computer science. The
newly developed syllabus has dealt with the dual challenge of reducing curricular load

as well as introducing this ever evolving discipline.

Punjab School Education Board welcomes and look forward to feedback and

suggestions for the improvement of its subsequent editions.

Chairman

Punjab School Education Board
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TYPING TUTOR

' CHAPTER - 1 | (PUNJABI)

( OBJECTIVES OF THIS CHAPTER )

4 )
1.1~ Touch typing
1.2 Different techniques for typing in punjabi
1.3 Keymaps of commonly used punjabi fonts
1.4 Numeric key pad
1.5  Important Keys on Key-board
1.6 Tips to improve typing speed
1.7 Proper Posture while typing
\ 1.8 Suggestions for Repetitive Stress Injuries/Discomfort during continuous typing )
INTRODUCTION

In this chapter, we will learn to expertise our typing skills in Punjabi. We will also learn
how to use keyboard properly and position of fingers on keyboard. Typing Tutor is a program for
learning touch typing.

1.1 TOUCH TYPING

Touch typing is a technique by which we can learn typing with all fingers, step by step,
without having to look down at the keyboard. If all the time, we keep on looking for right keys
on keyboard, it will slow down our typing speed a lot. As shown in figure below, the keyboard is
divided in two parts: one for the left hand and one for the right hand.

Fig 1.1: Keyboard divided into two parts for typing: left and right
TyriNG TuTor (PunJgagi) 1



1.2 DIFFERENT TECHNIQUES FOR TYPING IN PUNJABI

As we know that Punjabi is a regional language of Punjab. On our Computer Systems or

Mobile Phones, we can type our text in Punjabi or any other regional languages too. So, we
should also know about various techniques of how to type in our Mother Tongue “Punjabi”.

Generally, we use two types of fonts for typing in Punjabi — Phonetic Fonts and Unicode

Fonts.

e Phonetic fonts are the fonts that have the Regional Language (such as Punjabi) characters

mapped phonetically on an English keyboard. Hence, we might type ‘k’ to write ‘&’ and

‘g’ to write ‘d’. Such fonts include AnmolLipi, AmritLipi etc. Phonetic fonts are non-
Unicode fonts.

e Unicode font is a font that covers a large portion of the Unicode (Universal Code) character

set to support multiple written languages. Since Unicode character set is so big, 120,737
characters in Unicode 8.0, we do not have any true Unicode font that covers the entire

Unicode character set. But we do have some fonts that cover enough Unicode characters

to support most commonly used European, Arabic and Asian languages. Those such
fonts can be considered as Unicode fonts. Arial Unicode MS, Nirmala UI, Raavi etc. are

the examples of Unicode fonts.

We may think typing with non-Unicode fonts that are mapped phonetically might be a great
idea; however, what we type is really not Punjabi but English in disguise. Only the characters

look like Punjabi. To type discernible (detectable) Punjabi is impossible with non-Unicode fonts.

Images below show how the text typed with non-Unicode fonts is still English.
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Fig 1.2 : Typing Examples for using Phonetic Fonts

In the fig. 1.2, AnmolLipi font has been used to type “UdH’. AnmolLipi font is a non-Unicode

font that has a phonetic map; hence, we can’t type real Punjabi with it. If we select the text and

change the font to Arial, we will see that we really typed ‘prm’. So, it only looked like “UgH’ but

was really ‘prm’. If we copy and paste this in our web browser’s search box, we will have pasted

< b

prm’.
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Not all non-Unicode fonts are phonetic fonts. Some font families such as Asses, Joy etc; are

non-Unicode fonts that do not have a phonetic mapping. They share their own unique keyboard

mapping.

Unicode fonts are not inherently phonetic. A Unicode font is a font that covers a large

portion of the Unicode character set to support multiple
Raavi Unicode font is the commonly used.

written languages. For typing in Punjabi,
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Fig 1.2 : Typing Examples for using Unicode Fonts

In the above example, we will see that typing “UgH’ with Unicode fonts results in real Punjabi.

If you type “UgH’ with Raavi Unicode font, then select it

and change the font to Arial, the font will

change back to Raavi. Why? Because Arial does not have any Punjabi characters. It is an English

font. However, if we select the text and change the font to Arial Unicode MS, the font will change

because Arial Unicode MS contains the characters for Punjabi. If we Copy & Paste the text written

using unicode Font “UgH’ in the web Browser’s search engine box, we will have pasted “UaH’.

Gurmukhi Keyboard Mapper : There are several
types of non-Unicode fonts and they have different key
maps for typing characters. Using various tools or
utilities, we can type our text in Punjabi (Gurmukhi)
Unicode font Raavi usingthe key-map of non-Unicode
fonts such as Asees, Joy, AnmolLipi etc.G-Lipi-CA
(GurmukhiLipi Conversion Application) is such a
Keyboard Mapper utility that helps us to type in Unicode
font - Raavi by using the Keymaps of Asses, Joy and
AnmolLipi fonts. This tool is developed by the Punjabi
Department of Punjabi University Patiala. Apart from
office work, it has become very easy to write in
Punjabi anywhere on the internet including Facebook
with the help of this Keyboard Mapper tool. This tool
can be downloaded from its official site http://
gurmukhifontconverter.com/glipica.html

TyriNG TuTor (PunJgagi)
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1.3 KEYMAPS OF COMMONLY USED PUNJABI FONTS

Different fonts can have different key-maps. Following figures shows the key maps of
Punjabi Unicode Font — Raavi and Phonetic Fonts — AnmolLipi
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Fig 1.4 : Key-Map of Unicode Font Raavi

Space-bar

Fig 1.5 : Key-Map of Phonetic Font AnmolLipi

These key maps assist us to type in Punjabi either using Raavi Unicode or using AnmolLipi
fonts. If we want to be prepared for typing tests for the various posts of Punjab Govt. then they
should go for practice using the Unicode font Raavi because as per the guidelines issued by
Punjab Govt., it is mandatory, otherwise if we just want to learn how to type in Punjabi easily,
then we should go for AnmolLipi font.

1.4 NUMERIC KEY PAD

Numeric Key Pad is present on right side of the keyboard. It provides an impressive and fast
method to work with numbers. This keypad is a square of keys rather than a line. We have to use
only one hand (Right Hand) to work with its keys. Each finger manages the keys of one vertical
line. The fingers that are used for working on these keys should be as below:

* Index Finger is used for 1, 4 and 7 keys
*  Middle Finger is used for 2, 5 and 8 keys
* Ring Finger is used for 3, 6 and 9 keys

4 COMPUTER SCIENCE



Little Finger is used for Enter, "+" and "-" keys

Thumb is used for 0 key
—_
2ause o -] o
sreak Num Lock Caps Lock Scroll Lock
e
>age.

Fig 1.9 Numeric key Pad

Note : To use Number Pad, Numlock should be kept ON. External USB numeric keypads are
also available in the market.

1.5 IMPORTANT KEYS ON KEY-BOARD

Spacebar : To put a space in between letter pairs we use spacebar key. We use our
dominant right thumb for the spacebar.

Enter key : It is used to move down to a new line. Use our right little finger for the
Enter key.

Backspace key : Deletes one character to the left of the blinking cursor. Use our right
little finger for the Backspace key.

Shift key : It is present on both the sides of key board. It is mainly used to write
capital letters. If we want to write a capital letter with left hand, press shift button with
fourth finger of right hand and similarly press shift button with fourth finger of left
hand to type capital letter with right hand.

Caps lock key : Press caps lock key if we want to type complete word, line or paragraph
in Capital Letters. Use our left little finger for the Caps Lock key.

1.6 TIPS TO IMPROVE TYPING SPEED

1.

A

Our hand/finger’s position should always be in home position. We must start from and
return to this position. We should reach for other keys from home position.

We should focus on accuracy not speed. Speed will come with time and practice.
Don’t look at the keyboard.
Be steady, even pace and strive for accuracy.

As we tap each key, we should say its letter to ourselves.

TyriNG TuTor (PunJgagi) 5



1.7 PROPER POSTURE

While typing we must know about the proper posture. So follow the steps written below:

1.

We should sit up straight, directly in front of
keyboard.

Our feet must be flat on floor.

Monitor should be at our eye level.

Our eyes should be on copy or monitor while
typing.

Our fingers must be curved and upright over
home keys.

We should strike each key with a quick snap
and then return to home position Keys.

1.8 SUGGESTIONS FOR REPETITIVE STRESS INJURIES/
DISCOMFORT DURING CONTINUOUS TYPING

1.

Position yourself properly at your computer. Your screen should be 2 feet away from
you and the top of your document should be at your eye level.

Your chair is at the perfect height if you can sit at your computer with your knees bent
at right angles and your feet flat on the floor.

Set up your keyboard so that it is flat or slightly elevated. Do not have your keyboard
slanted downward.

Keep your wrists straight and elbows in a 90 degree angle while typing. Your wrists
should not rest on the table while typing.

Rest your wrists when you are not typing.
Take frequent short breaks rather than one long break.

Stretch your wrists before you start to work and during breaks, and strengthen your
wrists with exercise.

Exercise regularly. Overall body conditioning seems to help guard against repetitive
motion injuries.

Points To Remember:

1.
2.

Touch typing is a technique by which we can learn typing with all fingers
The keyboard is divided in two parts: one for the left hand and one for the right hand.

There are many fonts which are available for typing in Punjabi, for example: AnmolLipi,
Raavi (Unicode Font), Asees, Joy etc.

AnmolLipi font is one of the easiest Punjabi Fonts to learn typing in Punjabi.

Fingers of both the hands are placed on the line starting with A, also called Home
Row.

COMPUTER SCIENCE



6. Numeric Key Pad is present on right side of the keyboard. It provides an impressive
and fast method to work with numbers.

7. To use Number Pad, Numlock should be kept ON.
To put a space in between letter pairs we use spacebar key.
9. Backspace key deletes one character to the left of the blinking cursor

10. Our hand/finger’s position should always be in home position. We must start from and
return to this position. We should reach for other keys from home position.

11. We should focus on accuracy not speed. Speed will come with time and practice.

12. Our eyes should be on copy or monitor while typing.

7 D
éﬂf EXERCISE )

1.  Multiple Choice Questions :

L. font can be used to type in Punjabi.

a)  AnmolLipi b) Raavi

c) Joy d) All of the Above
II.  What is the full form of UNICODE ?

a)  Union code b)  Unified code

¢)  Universal code d) None of these

III. Which of the following is the unicode font for typing in Punjabi ?

a)  AnmolLipi b) Raavi

c) Asses d) All ofthe above
IV. Which of the following is a phonetic font for typing in Punjabi ?

a)  AnmolLipi b) Raavi

c) Asses d)  All of the above
V. To use number pad, should be kept ON

a)  Num lock b) Caps Lock

c¢)  Scroll lock d) None of These

2.  Write True or False

I.  Fortyping, keyboard is divided in two parts: one for the left hand and one for the right
hand.

II.  Touch typing is a technique by which we can learn typing with all fingers while looking
at keyboard.

III. AnmolLipi font helps us typing in Punjabi.
IV. We use our little finger for the spacebar.

V. Shift key is used to move down to a new line.

TypiNGg TuTor (PunJsasI) 7



Short Answer Type Questions

I.  What is Touch typing?

II.  What are the different types of fonts used for typing in Punjabi ?
III. How to type in Punjabi language?

IV. Name any three fonts to type in Punjabi Language?

Long Answer Type Questions

I.  How can we improve typing speed?

II. What are the important things that should be taken care for the proper posture
during typing ?

COMPUTER SCIENCE



Activity,

HOME ROW EXERCISE - I

Oresar  BadAg Oresar  BaAg Oresar BaAg  OFesar  ®aAg
Oresar  BadAg Oresar  BaAgT Oresar BaAg  Omesar  ®aAg
Oresar  BaAg Oresar  BIHT Oresar BIAg BAEsar  BIAT
Oresar . BadAg Oresar  BaAg Oresar BaAg OFesar ®aAg
Oresar  BaAg Oresar  BaAgT Oresar BaAg  Omesar  ®aAg
HOME ROW EXERCISE - 11
NHUSW BUS MHUSW BUY NMHUSW BT WMHUSW BUS
NHUSW BUS MHUSW [ BUY MHURW BT WHUSW  BUS
WHURW  BUY MHTRW  BYY WMHURW  BYF WMHURW  BUY
NHUSW BUS MHUSW BUY NMHUSW BT WHUSW  BUS
WHOURW BYy MHATSW B4y MHOSW [ BUY HHTSW [ BYY
SECOND ROW EXERCISE-III
grfeges u— grfege y—f grfege y—f "
grfege uf grfege u-f -~ grfege uf "
grfeges u— Irfege uf " grfege uf "
grfege uy - f_ grfeae y—f " grfege gy f ™
grfege uf grfege uf " grfege v f ™
TypiNGg TuTor (PunJsasI) 9




SECOND ROW EXERCISE-IV

gt6€. 3 G gt€. 3 AR - ] A
gt€. 3 N gt68. 3 e Y. ®tEw A
gt&. 5 gt gtg s e Y. wtEw g 1.7
gt§'5 e 1 SO e T §t€® A
gt€. 3 G - S ) AR - ] e t_7
HOME ROW AND SECOND ROW EXERCISE-V
Eregasz € Sf um; Gregas € Sf um;
Gregzsz e f um Gregzs e f um
@reg3aszst Sf oua; Greg3aszst Cf oua;
€regas € sf oum; €regas € Sf um;
Gregasz € Sf ue; Gregas € Sf ue;
HOME ROW AND SECOND ROW EXERCISE-VI
o ufgam T ®EEHC  MUUBT wabee wBwsr el
Sfew sQeee uele _AG® Aemer efsee B
SJoH Resr) HA(5S J_usE WIGHA T _me weufse
g@ove  Ffaee G3fu gefs SITH WAITE pSroryal
HOME /SECOND/THIRD ROWEXERCISE -VII
S s FIHNSTH MITTEIT BY'gY
S= s BIHNSTH MITTEIE BY'gY
S s BIHNSTH MITTEIE BY'gyY
S s BIHNSTH MITTEIE BY'gyY
Cazsg=z BIHNSTH HMIATTEIE BY'gY

10
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FOURTH ROW EXERCISE-VIII

12345 098767 T #4% HE*()
12345 098767 T #4% HE*()
12345 098767 T #4% HE*()
12345 098767 T #4% HE*()
“12345 098767 T #4% e *()
EXERCISE - IX

ATTER BU wa 83 feas™
afugea ICERS A% iU UfAs
HE™ HaTt EEICIES festmr fo e
g% fefgam afe3 feam yAret
goteafiet At g, HEwH CILICCES Hoted
IJHSIST MHdtaT JTeT yet ¥°r

EXERCISE - X

U7y gategfiet ufersT & Setn 9sg 37. Anu® fiw & ferr fagent w3 damst
fegmar € yit . su<te fiw, §. sse< filw 9y, 37. ef<es fiw &t nereret feT asfent
37. JAfeEd fiw w3 1. IdadIe fw & At-fautar s T mfagr Arge=wag famma a3
J fAn g7at @e3dt ovaTH 3 fewreT eRga M3 f¥eda @ 3 39 fag =t UAmt fe9 fayer
993 AT T fapdm 31 fE 5 39 fa At viruST e-1s St vy fam 8T AT o € AETs 3
Jraret 9 97 Aawe 7 | faBfa feo Argee e 307§ Uamet gatas 8¢ (I<t) fRe aH da5
& Ag®3 Qusey ge=gEr I
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INTERNET

' CHAPTER - 2 | FUNDAMENTALS

( OBJECTIVES OF THIS CHAPTER )

-

~
2.1  What is Internet?
2.2 History of Internet
2.3 Requirement for Internet
2.4  Facilities provided by internet
2.5  Internet Connections
2.6 Modem and Its Types
2.7  Internet Service Providers (ISP)
2.8  Services provided by Internet
2.9  Tools and Skills required for using Internet
\_ 2.10  Web Browsing )

INTRODUCTION

Today the use of internet has increased tremendously. Before learning about methods of

using internet, let us learn what is internet and how it came into existence.

In 1986 National Science Foundation has prepared its network named NSF. Through this

network, scientists shared the use of a super computer. (Super computer is a larger and powerful

computer which is used for scientific

A
purposes.) I3
In 1990, the Defence Department Web User
stopped working and it merged into NSF net.

There after, it was connected to many other
networks. It resulted in internet being used
today.

2.1 WHAT IS INTERNET?

Internet is one of the best technologies
gifted to mankind in the present scenario. It
has brought the entire world at our fingertips.
Let us learn what is internet and how it came
into existence.

12

Figure 2.1 internet
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The name ‘Internet’ itself suggests its meaning. It stands for International Network of
computers. A network is an interconnection between two or more computers. The Internet is a
“network of networks’ that consists of millions of computers spread across the world. Internet
allows us to share the information worldwide, just with a mouse click.

2.2 HISTORY OF INTERNET

In 1969, when man walked on the moon; the U.S. defence department set an Advanced
Research project Agency (ARPA) for further research. They designed a network of four
computers to exchange and share their data. This network was called ARPANET (Advanced
Research Project Agency Network). Later, many universities were allowed to join this network
and share the information. This was the beginning of ‘Networking of computers’ which grew
bigger day by day and gave birth to INTERNET- the technology which has changed our life.
Earlier, Internet was used by engineers, scientists and computer experts for research purpose.
Gradually, the network was made accessible to private agencies and general public. People started
using it for sending messages and files between the computers. The most interesting thing about
Internet is that no single agency controls or maintains the Internet.

In India, internet services started on 15th August 1995 through government owned VSNL.
Private internet service providers like Airtel, Reliance, Sify, Tata etc. have also been allowed to
provide internet services

2.3 REQUIREMENTS FOR INTERNET

For using internet, we require both Hardware and Software resources which are given
below:

Hardware Requirements:
* A personal computer with a speed of 800 MHz or more
* RAM of about 128 MB
*  Telephone line ISDN (Integrated Services Digital Network) Connection
*  Modem to link Internet
NIC-Network Interface Card

Software Requirements:

*  Operating System: e.g. Windows XP, Windows 7, Windows 8, Linux etc.
*  Web Browser: e.g.Internet Explorer, Mozilla Firefox, Google Chrome etc.

*  TCP/IP protocols (rule)

2.4 FACILITES PROVIDED BY INTERNET

Network is a group of two or more computers linked together through network. If two or
more networks are joined together then they form inter-network. Internet is a inter-network of
whole world. Thousands of networks are joined with internet. Internet provides us many facilities.
Some of them are given following:

INTERNET FUNDAMENTALS 13



Fig 2.2 Uses of Internet

News and Information : Internet provides the facility to read different newspapers
online and get the information regarding various topics of our interest such as politics,
sports, education etc. It also keeps us updated with current events.

Art and Entertainment : Internet allows us to download and purchase various software
for art and entertainment such as games, songs, movies, puzzles, jokes, stories etc.

On-Line Shopping : We can purchase various items like books, clothes, gift items
etc. from different e-shops around the world without actually going there.

Mailing Letters : Electronic mail is the most popular feature of the Internet. It allows
us to send and receive messages. We can also attach pictures, videos, audio files to our
email and send it to anyone.

Health and Fitness : We can have an all-time doctor at our service to provide health
and fitness information. We can also search for remedies and precautions for different
diseases.

Tourism and Travel : Internet provides facility for online booking of hotels, railway
tickets, air tickets etc. all over the world and round the clock.

Chatting : Internet allows us to exchange text messages with another person anywhere
in the world.

Banking Operations : Now all Banking operations can be done right from our home
using Internet / e-banking services.

Video Conferencing : Through video conferencing, we can communicate with the
other person visually. To do video conferencing, both the persons need to have web
cameras.

2.5 INTERNET CONNECTIONS

In today’s era, there are numerous ways to connect laptops, desktops, mobile phones and

tablets with the Internet. When determining which type of Internet connection is right for us, it’s
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important to understand the distinction between each connection. Some of the most widely used
Internet connections are listed below:

Types of Internet Connections:
Any one of the following basic connections is used for using internet.
*  Dial-up Connection
*  Broadband
*  Wireless
*  DSL (Digital Subscriber Line)
* ISDN (Integrated Services Digital Network)

Through dial up, a computer communicate with other computer. These connections can be
established with telephone line or cellular device. This connection is used by the users who use
internet occasionally.

Broadband connection joins computer to the lines of telephone or transmission institute. It
is always used with high speed. Business centers, Universities and other high demand users have
a permanent internet connection.

Small businessmen or personal users have personal lines of DSL (Digital subscriber line)
for permanent connection. This facility is costlier than dialup connection.

2.6 MODEM & ITS TYPES

Full Form of MODEM is Modulator-Demodulator. A modem is a device that enables a
computer to transmit data over telephone or cable lines. Computer information is stored digitally,
whereas information transmitted over telephone lines is transmitted in the form of analog waves.
A modem converts between these two forms i.e. by converting the digital data used by your
computer into an analog signal used on phone lines and then converting it back once received on
the other end.

Fig 2.3 Modem

Speed of modem is variable. Slow modem takes more time to send or receive message. It
takes more time to copy files from Internet.If both the computers of transmission have different
speeds of modem, then transmission will be according to the slow speed modem. So use only
fast speed modem. Generally a modem with 28.8kbps speed is used. Surfing needs modem
speed not less than 56 kbps.

INTERNET FUNDAMENTALS 15



Types of Modem : Modem is of two types: External and Internal which are explained
below:

i. External Modem is linked to computer externally with cables.

External
Modem

Fig 2.4 External Modem

ii. Internal Modem is fitted inside the computer. Cable or telephone wire goes to modem
through plug. Now-a-days wireless modems are available which work like a mobile phone.

Fig 2.5 Internal Modem

2.6 INTERNET SERVICE PROVIDERS(ISP)

Internet Service Provider (ISP) refers to a company that provides Internet services, including
personal and business access to the Internet. For a monthly fee, the service provider usually
provides a software package, username, password and access phone number for e.g. Airtel,
Vodafone, BSNL. Equipped with a modem, you can then log on to the Internet and browse the
World Wide Web and USENET, and send and receive e-mail. For broadband access, you typically
receive the broadband modem hardware or pay a monthly fee for this equipment that is added to
your ISP account billing.

In addition to serving individuals, ISPs also serve large companies, providing a direct
connection from the company's networks to the Internet. ISPs may also be called IAPs (Internet
Access Providers).
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Fig 2.6 Internet Service Provider

2.7 SERVICES PROVIDED BY INTERNET

In today's technological world, there are plenty of services that are provided by the Internet.

The list contains email, which enables you to keep in contact with friends, family, and employers.

There are also search engines that allow you to search for information that is provided by

professionals and individuals alike. Other services include sites like Facebook and MySpace

that allow you to interact socially with people from all over the world. Most businesses today are

connected to the Internet so you can also pay bills, do banking, and shop online. Some of the

main services are described below.

I.

I1.

World Wide Web : The World Wide Web (WW W) and the Internet work together but
they are the different things. The Internet is a global network of networks while the
World Wide Web (www) is collection of information which is accessed via the Internet.
We can access the information stored on the www by using the web browsers such as
Internet Explorer, Mozilla Firefox etc.

WWW consists of all the public web sites connected to the Internet. The websites are
identified by short, unique, global identifiers called URLs (Uniform Resource
Locator). World Wide Web consists of a large number of websites or sites. It includes
e-mail, newsgroup, mailing list, news groups etc.A website is a collection of inter-
linked web-pages. We can obtain information from these web-pages. Accessing
information stored on the World Wide Web is called Web Surfing.

Electronic Mail : Electronic mail is more commonly known as email.We can send
and receive messages with the help of e-mail to any part of the world. Text, video,
audio and other files can also be sent and received through it.Today, email is considered
as the most popular service offered on the Internet. Email has become the preferred
method of communication for sending, receiving and storing electronic messages.
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The U.S. Postal Service handles around 200 billion pieces of mail each year. Email
service on the Internet handles around 247 billion emails every day.

Fig 2.7 E-Mail

Advantages of E-Mail : E-mail has following advantages:

®  Cost : Cost given for use of internet is the only money given. User need not to give
money for postal stamps. It is cheaper than fax. The e-mail does not need such costs.
Cost of long message is equal to that of short message. Also cost of sending message
to very far off distant locations is same as that for sending message to our own city.

® Speed : Its speed is greater than postal transmission. E-mail message can reach its
destination within no time. We can correspond any times in a day.

¢  Convenience : Computer user can type the message in his computer and send e-mail
at any time of his convenience. It saves paper, postal cost and any other problem.

ITI. E-Commerce : The ability to do business without the usual constraints of time or
distance make e-commerce one of the most important services provided by the Internet.
With the single click of a mouse, online customers can purchase almost anything day
or night from the comfort of their own home.

. SELECT PRODUCTS

Fig 2.8 E-Commerce

IV. Social Networking Sites : The Social networking websites function like an online
community of internet users. In social Networking websites, every user has a profile,
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which contains information about them. A user can also invite other people to join
these websites. Some of the popular social networking sites are: Facebook, twitter etc.

Fig 2.9 Social Networking Sites

V. Video Conferencing : It involves the use of video cameras connected to two or more
computers. Images and sounds are then sent through the Internet where users not only
hear each other but can also have a face to face conversation.

Fig 2.10 Video Conferencing

VI. Chatting : A chat is an online conversation over the Internet in which we can instantly
send text based messages back and forth to one another. Thus, Chatting means — word
talk. It is similar to telephonic conversation. The only difference is that we use only
words in chatting. If we are linked through internet then we will type message in
computer or mobile,instead of speaking in telephone. Now voice chatting is also
possible using internet. In voice chat we can speak and listen.

VII. Web Searching : Number of web pages are not fixed on website. Web pages are
unlimited on the World Wide Web. These web pages go on increasing with the creation
of new websites. Big companies save their web pages in their database.Search
enginesare used to find information on the web. It is a powerful program. Desired
information can be found by typing appropriate words in the search engine. After
searching the information on the web, search engine shows a list of websites related to
that word on the screen.

Methods of searching : Let us learn about fundamentals of searching. First of all type a few
words in the text box of search engine. In advance search you have to set word match, complete
phrase match or insert key-word match.

INTERNET FUNDAMENTALS 19



Following things should be kept in mind while searching in a right way:
*  Use (+) sign for that word which should be present in search result.

*  Use (-) sign for the word which should not be present in search result

*  Use quote marks ('.")to show phrase

From the example given below, it is clear that we are finding cookie recipe site of North
India and it should not contain information about rice i.e. cookie + recipe — rice.

| & coviiesrecipe -rice - GoogleSe: % | + - a8 X
€ = C @& googlecom/search?ssrf=ALeKk002DSThUKA1TRART Q316017 000siP4-EPrSel2AQRIg=¢ 2Brecipe+-riceBloq=cockie.. Tt @ O N @
Google cookie+recipe -fice ®x & Q i w
QA [ Vdeos [ Images Mews [ Books i More Settings  Tools.
About 1,88,00,00,000 resulls (0.49 seconds)
Rec:pes
z E ‘ 5 ﬂ“
The Best Chocolate Chip Cookie recipes Ultimate Chocolate Chip
Cookie Recipe Ever Cookies
JoyFoodSunshine EBBC Good Food Batty Crocker
50 %%k &k &k (1.1K) Ho reviews 4.5 %4k &k d (1.1K)
30 mins 1 hr 30 mins
Brown sugar, chocolate chips, Cookde Brown sugas, chocolate chips,
white, 6ggs, baking soda 09, baking soda, vanila
~ Show more

Jeylcodsunshine.com » the-most-amazing-chocolatech... =
How to make The Best Chocolate Chip Cookie Recipe Ever
sxﬂ 55; Feb 11, 2018 - Ingredients. 1 cup salted butter” softened. 1 cup white (granulated)

e 4 e Bkl Ren onar naebad 9 len rirs wandlls avieset 3 lama anne

Fig 2.11 Web Searching

2.8 TOOLS AND SKILLS REQUIRED FOR USING INTERNET

We should have complete knowledge of computer in order to take full advantage of internet.
Difterent tools are used for different purposes which depend on our requirements. Following are
some of the important tools:

*  E-mail program
*  Web Browser
* News Reader
*  FTP software

Although, software for internet has been greatly improved yet the internet user need basic
computer skills of using it. User should know how to start or close a program, how to copy a file,
he should know something more than menu, icon, print, type and editing. Knowledge of all these
things is called basic computer skills for using Internet.

2.9 WEB BROWSING

It is the Searching process on the web. Moving from page to page or website to website in
search of information is known as Web Browsing. To browse the information, we can take the
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help of any search engine such as Google, Bing etc. We can view required information with the
help of Browsers & Search engines.

*= C (D wawgoogle.co n g _rds ol Aol LTS THWCD) o A

o oo e 13 [

Google

Comnpr brarch Frm lemiing Lasky

Gosge gam el . 90 T Joct; BB m !-,-“.41 g B it

g Butneis L Pesacy & Teeema, Samngn Lies Goagle com

Fig 2.12 Web Browsing

Points To Remember:

1. The Internet is a “network of networks” that consists of millions of computers spread
across the world.
E-mail is a facility on Internet to send and receive messages to any part of the world.

3. Internet explorer is one of the most popular and widely used web browser developed
by Microsoft.

4. Each Web page has a unique address called Uniform Resource Locator.
World Wide Web (www) is collection of information which is accessed via the Internet.
Moving from page to page, website to website in search of information is known as
Web Browsing.

& T exerese)

1.  Multiple Choice Questions:

I.  International Networks of computers is known as
a) ARPANET b) INTERNET

¢) INTERANET d) ETHERNET

II. WWW stands for .
a)  World Wide Web b)  World Web Wide
c)  Wide World Web d) Web World Wide
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. A is an online conversation over the Internet.

a) E-commerce b)  Chatting
c) WWW d) None of these
IV. is the fastest way of sending mails.
a) Telegram b)  Letters
c) ISP d) E-mail
V. is a device that connects a computer with telephone line.
a) Modem b)  Telephone Wire
c) Mouse d) Mobile
Full Forms:
. WWW II.  E mail
I11. MODEM IV. ISP
V. URL VI. DSL

Very Short Answer Type Questions:

I.  What is Internet?

II.  Give some examples of Internet Service providers.
III. What do you mean by the term E-Commerce?

IV. What is Web Browsing?

Long Answer Type Questions

I.  What is MODEM? Also explain its types and speed.
II. Explain the facilities provided by the Internet.

III. What is E-mail? Write the advantages of using email.
IV. Write a note on World Wide Web.

V. What are the main services provided by Internet? Explain briefly.

[CabrActivitby,

Make a group of 5 to 8 students. Go to the lab and find out different components being
used for internet.

Search for any topic like car, mobile, computer, motorcycle etc using search engine.
Do as the following:

a) Open www.google.com in any web browser

b) Search for “fonts of Punjabi”

c) Click on the appropriate link and download fonts in the computer system
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INTRODUCTION

Now-a-days many companies are in the field of Information Technology. These companies
are earning a lot because of good standards and their in creative and competitive marketing
policies. This is possible only if proper information is received at a proper time and these
companies are working on basis of this information these days. It is known as era of information
technology.

Information technology is related to computer hardware and software. The technology
which is used for processing, storing and exchange of information is called information technology.
Information technology plays an important role in the development of a country. It is changing
the life style, learning, playing and working styles of people.

We are introducing new social programs, scientific discoveries and business devices due to
development of computer information technology. New tools of communication to collect
knowledge and information are being framed.

3.1 WHAT IS INFORMATION TECHNOLOGY?

It includes all the technologies used to store, change or use information about
business data, voices, discussions, photographs, movies, multimedia presentation etc.
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Information technology is an advantageous field which includes both telephone and computer
technology.

3.1.1 Need of Information Technology

In our daily life all bills and payments of most of the Govt. and private firms are printed with the
help of computer. ATM facility of banks is also very useful but it is possible only due to proper
use of computer.

Information technology is used to perform many tasks as mentioned below:

i.  For Business and Industry : Information technology is used in business and industry

for following purposes:

* Office Automation : Information technology helps to perform routine office work

and to increase productivity in the business and industry.

®* Management Information System : Information technology helps the manager to
take quick decision in the business and industry.

ii. At home : Information technology is used to perform following tasks at home:

¢  Communication : Instead of sending letters, we can communicate with email and

chatting.

®  Education : Student use internet for their study. There are various types of educational
software which help students to do their study at homes.

* Entertainment : The older means of entertainment are replaced by computer and

internet. Traditional tapes and cassettes have been replaced by audio-video CD's/DVD’s.

ili. For Training : In schools,Information Technology is used to provideeasy and
effectiveknowledge to students by teachers. Effective multimedia presentation contents
are proving very helpful in this regard. Information technology is also helpful in the
field of science and medicine.

3.2 WEB SITES

A collection of one or more web pages grouped under the same domain name is called
Web Site.

The pages of a website can usually be accessed from a simple Uniform Resource Locator
(URL) called the web address. Each website has its own unique web address which can be
reached through an internet connection. For example web address of Punjab School Education
Board is www.pseb.ac.in. The opening page of a website is usually called homepage which
contains hyperlinks to other pages on the same or other website(s) A company or an individual
tells us how to get their Web site by giving us the web address of their home page. From the
home page, we can get to all the other pages on their site.
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Fig 3.1 Web Site

3.3 SEARCHING

In English search means:“Try to find something”. Web search is the act of looking for

webpages. The system that collects webpages together for required information/topics at one
place is called a web search engine.

When we ask a web search engine such as Google or Bing find webpages related to a topic,
we will get back a list of hyperlinks related webpages. This list may have a hundred or more
links. They are often divided up into a number of Search Engine Results Pages (SERPs). From

SERP, we decide which link we should try and see if it’s referenced page had what we’re looking
for.

googlecoiniTgfe_rds criuei= EEQUVELKLanVEgf W

+You Gmail Images i Sign in

India

Google

Google Search I'm Feeling Lucky

Google.co.in offered in: =0 AWM e w8 HUID vl sRd DRwIge Yee

Fig 3.2 Searching
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3.4 WEB SURFING

Web surfing means to move from place to place (one website to another website) on the
Internet to search for the topics of interest. The term also has another meaning -- spending time
on the Internet.

Web surfing has become a favourite pastime for many Internet users. Just as in "TV channel
surfing," where one clicks the remote to go from channel to channel, the hyperlinks on Web
pages make it easy to go from one page to another.

3.5 DIFFERENCE BETWEEN OFFLINE AND ONLINE

The terms "online" and "offline" have specific meanings in regard to computer technology
and telecommunications. The general definition of "online" simply indicates a state of connectivity,
while "offline" indicates a disconnected state. Working online means that we are working on
files and/or programs that open from external sources, like a server or website. Working offline
means that we are working on something on our computer.

= @&

Online Offline
Fig 3.3 Online and Offline
Online = connected / having access to a network or Internet

Offline = not connected / not having access to a network or Internet

3.6 DOWNLOADING

Downloading means our computer is
receiving data from the Internet. Every time we
use the Internet, we are downloading data. For
example, each time we visit a webpage, our
computer downloads the HTML and CSS codes,
images, and any other relevant data. Only after
downloading web page data, a web browser can
display it properly on the monitor screen. When
ever we click on "Download" link of a file, our

web browser will start downloading that specific
file.

Examples of downloading include opening
a web page, receiving email, downloading music
files, watching online videos etc.

Fig 3.4 Downloading
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3.7 WHAT IS NET BANKING?

A system of banking in which customers can view their account details, pay bills, and
transfer money to others by means of the Internet, is known as Net Banking.

Internet banking is also called Online Banking. Internet banking uses the Internet to conduct
banking activities, for example: transferring funds to others, paying bills, viewing our own account
balances etc. Banks that provide the facility of Net Banking are also known as Virtual Bank or
Cyber Banks or Web Banks.

[osneamamm-wmue.n x| + - 8 x
y
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osBl A-‘a’!‘ll Heme Loan | About OnlineSB1 | Forms | Net Bani Branches| M
(0] ling |
ONCINE =]

Products & Services How Do |

Login to Online SBI Dear Customer, we have introduced CAPTCHA (Image & Audio) as part of Login process. Welcome to Personal Intemet Banking

{CARE: L d )

Usemame*
New User 7 Register here/Activate

Foegot Login Password

For batter control & securty of your
account, you can Lock or Unlock your INB
access trough ink “Lock & Unlock User”

Enter the text 25 shown in the image *
avallabia at bottam of this Page.

Select one of the Captcha options * O Enabie Vitusl Keyboard ) ) -

@ image Capteha O Audio Capteha

For better secusity use the Onfing Virtual Keyboard 1o login, More .
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Fig 3.5 Net Banking

3.8 WHAT IS “ON LINE SHOPPING”?

Online Shopping or Online Retailing is a form of electronic commerce which allows
consumers to directly buy goods or services from a seller over the Internet using a web
browser.

We can purchase products from almost anywhere
if the vendor makes his products available through the
Internet. We can pay the bill of our shopping by using
a credit/debit card or net banking etc. The good thing
is that purchasing things online is very easy. The
advantage for online shopping is that we can purchase
items from home and the items will be delivered at
home.

Do we have plenty of time to go to the store and

look up and down for the items we like? Most people
say NO, time is precious. So, on line shopping is

Fig 3.6 Online Shopping

considered as a time saving activity.
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Fig 3.7 Online Shopping Website

3.9 HOW TO VIEW ONLINE -RESULT?

In earlier days, we have to wait for the result gazette (Manual document of result published
by board or universities) to see the results. But with the help of Information Technology, we can
view the results online. For example: if we want to view the results of classes under Punjab
School Education Board then we can perform the following steps:

*  Open any web browser, such as - Internet Explorer, Mozilla Firefox etc.

* In the address bar, type website address of Punjab School Education Board, i.e.

www.pseb.ac.in

*  Click on “Result” Link. It will open a web page showing links for various results

| # Compiete Result Listings of Pun: X | =+ - o X

& » C A Motseoure | punjab.indiaresulis.com/pseb/default.aspr a fw ® 0O 8@

Home > Punjab > Punjab School Education Board

Punjab School Education Board

07/10/2020 Result of Senior Secondary (10+2) Revaluation, March 2020 (Part - Il NOW AVAILABLE
@ Ads by Google (_MarksheetApp ) ((PsebACinApp) (UG Courses )

23/09/2020  Matric Punjabi Additional Subject Result, March 2020 NOW AVAILABLE

15/09/2020  Sr Sec Revaluation Result March 2020 NOW AVAILABLE
10/09/2020  Result of Matriculation Reappear Open School ( appeared in one or two subjects) March 2020 NOW AVAILAI
05/09/2020  Sr Sec Rechecking Result March 2020

23/07/2020 Senior Secondary (10+2) Examination Provisional Result March 2020 (Vocational Stream Included) NOW
AVAILABLE -

Fig 3.8 Viewing online results
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®  (Click on the Result link that we want to see.
*  Fill our exam details, such as roll no, name etc.

®*  (Click on “Find Results” button.

Home @ Punjab @ Punjab School Education Board

Punjab School Education Board

Matriculation Examination Result March 2014

To get your results on SMS type PB10 <Roll No> & send to 5676750
e.g. PB10 1014500001 send to 5676750

Enter Roll No Find Results

OR
Enter Name Find Results

Fig 3.9 Viewing online Result

*  Now, the result will be displayed on our screen. We can also take the print of our
result.

3.10 MOBILE TECHNOLOGY

The meaning of mobile technology is clear from its name itself - a technology that is
portable.

Fig 3.10 Mobile Technology

Mobile technology is rapidly changing the face of communication in the most remote
areas of the world. Today, out of the seven billion people in the world, approximately six billion
are cell phone subscribers. In response, companies, governments, and NGOS alike have realized
the potential of this tool in addressing today's most pressing global challenges. Here are some
important uses of Mobile Technology.
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Education

Surveys and Polling
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Data Analysis

Points To Remember

1.

A collection of one or more web pages grouped under the same domain name is called
Web Site.

Web search is the act of looking for webpages.

Web surfing means to move from place to place (one website to another website) on
the Internet to search for the topics of interest.

"Online" simply indicates a state of connectivity, while "Offline" indicates a
disconnected state.

Downloading means our computer is receiving data from the Internet.

A system of banking in which customers can view their account details, pay bills, and
transfer money to others by means of the Internet, is known as Net Banking.

Online Shopping or Online Retailing is a form of electronic commerce which allows
consumers to directly buy goods or services from a seller over the Internet using a
web browser.

The meaning of mobile technology is clear from its name itself - a technology that is
portable.

Vo VS

{ ] EERCBE )

1.  Multiple Choice Questions:

1.

1l

1il.

1v.

30

means our computer is receiving data from the Internet.

a) Uploading b) Downloading

¢) Surfing d) None of these

The first opening page of a website is usually called

a) Home Page b)  Web Page

¢) Main Page d) None of these
indicates a state of connectivity.

a)  Offline b)  Online

c) Inline d) None of these

means to move from place to place (one website to another website) on the

Internet to search for the topics of interest.

a)  Web Searching b) Downloading
c¢)  Web Surfing d) All of these
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V. is a form of electronic commerce which allows consumers to directly
buy goods or services from a seller over the Internet using a web browser.

a)  Net Banking b) E-Mail
¢)  Online Shopping d) Mobile
2.  Write True or False:
I.  The result of any board or university can be seen online.
II. Offline means we are connected with the Internet.
ITI. A website has only a single web page.
IV. Web search is the act of looking for webpages.
V. Each website has its own unique website address.
3.  Fill in the Blanks:
I. A collection of one or more pages grouped under some domain is called
II. means not connected with Internet.

II1. technology is providing us new tools of communication to collect
knowledge and information.

IV. Banks that provide the facility of Net Banking are also known as
V. We can buy goods from home using
4. Short Answer Type Questions
I.  What is Information Technology?
II.  What is Website?
III. What is searching?
IV. What do you mean by online and offline?
5. Long Answer Type Questions
I.  Explain the Need of Information Technology.
II.  Write the steps to view online result.
ITII. Write a note on Mobile Technology
IV. Explain about on-line shopping?
V. What is Net Banking? Explain?
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‘\- MICROSOFT POWERPOINT

| CHAPTER - 4 | (PART-I)

( OBJECTIVES OF THIS CHAPTER )

4 )
4.1  Introduction to PowerPoint
4.1.1  What is Presentation?
4.1.2  What is Slide?
4.2  How to Start PowerPoint?
4.3  Components of PowerPoint Window
4.4  How to Create Photo-Album Presentation?
4.5  How to Play Presentation for audience?
\ 4.6  Saving and Exiting Presentation )

4.1 INTRODUCTION

Microsoft PowerPoint is a professional presentation software. It is one of the major
components of Microsoft Office suite.It was developed by Robert Gaskins and Dennis Austin
for the American computer software company Forethought, Inc. Initially, it was named Presenter.

PowerPoint is very easy-to-use presentation graphics software. It allows us to create very
impressive and professional looking electronic slide-shows. Presentations developed in the
PowerPoint can be displayed on the computer Screen or through a projector that is plugged into
the computer. A PowerPoint presentation is a good way to convey our ideas or information to a
large audience.Before proceeding in this chapter, we must know to get in touch with some of the
basic concepts related to PowerPoint, which are given below:

4.1.1 What is Presentation?

A presentation is the process of presenting a topic to an audience.The aim of presentation
is to make subject matter easy to understand by inserting pictures, text, graphs, charts, animation
etc. We can insert animation effects, audio and video clips in our slides to make our presentation
effective.A presentation may consist of one or more slides.

4.1.2 What is Slide?

Aslide is a single page of presentation. It is just like a 35mm film based slide. A slide can
be considered as a work-area in PowerPoint where we put contents for creating presentation. We
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can put many types of contents such as Textboxes, Shapes, Clipart, WordArt, Tables, and SmartArt
etc. on the slides. A presentation may have one or more slides.

4.2 HOW TO OPEN POWERPOINT?

PowerPoint can be opened in many ways. Following are some of the common methods to
open PowerPoint in the Windows Environment:

a. Using START button
b. Using RUN command
c. Using ICON from Desktop
Following discussion explains how to use these methods:
a. Steps to Open PowerPoint Using START button:
i.  Click on Start button
ii.  Click on All Programs
iii.  Click on Microsoft Office folder
iv.  Click on Microsoft PowerPoint 2010

[ Start H All Programs H Microsoft Office ]—>[Microsoft PowerPoint 2010]

b. Steps to Open PowerPoint Using RUN box:
i.  Open the RUN box by pressing Window Key + R

ii.  Type powerpoint

iii.  Click on OK button or Press Enter key from keyboard

2 Run X

=7 Type the name of a program, folder, document, or Internet
= resource, and Windows will open it for you.

Open: | powerpnt T |
I 0K | l Cancel ‘ | Browse... |
Fig 4.1: Run Box to Open PowerPoint _I
A P=
c. Steps to Open PowerPoint Using Icon on Desktop: F - {
If PowerPoint icon exists on the desktop then double click on it to livh e cspgefis
Open PowerPoint. BOWETEOINT
ANy
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4.3 COMPONENTS OF POWERPOINT WINDOW:

After Opening Microsoft PowerPoint 2010, following window will appear on the Desktop.
This window contains many components that are similar to other Microsoft Office programs.
Each component serves a special purpose. It is important to familiarize with these components
as it makes learning and using PowerPoint easier.

Quick Access Toolbar

File Tab / Tabs Title Bar
\ / Vi
DRI [/ Presentasal - Mireieh PowsrPoint / - B8 x
Home | man f Desgn  Transions Anmations  SadeShow  Rewes  View a @
; [ P =) E:"‘:" AN % E-E e - BNAooo- d [ |2 i
Rlbboﬂ{ Facte -j;;'-f,—w--- e -‘in:‘lm, B I U S -o|A- EZIE( N Ql}\'?{}}g hrange y
mu“;‘;ﬂ : ;h = |.| W [ s ; H -»a--l-':::--- 7]
1 I__
ine/sli [ slide
Outline/Slidé¢s Tabs Il —
Il
. .
| Click to add title
; el
[: ; Slide Pane
\
Click to add notes 3
Sace 101 | “Offce Theme™ | Enghun padia | '\ [CETEr e 8
Status Bar Notes Pane V&v Options

Fig 4.2: Showing Parts of power point Window
A brief introduction of the PowerPoint Window components is given below:

¢ Title Bar : It is the top most bar of the PowerPoint window. It shows the name of
currently opened presentation along with the software name, i.e. PowerPoint. It has
three buttons named: minimize, maximize/restore and close buttons at the right side.

‘I H9-0|+ Presentation3 - Microsoft PowerPoint — O] X

®  Quick Access Toolbar : It is present at the left side of the Title bar. It contains buttons
for commonly-used commands.

® Ribbon and Tabs : Ribbon is located on the top of the PowerPoint window just
below the Title bar. There are eight standard tabs in the PowerPoint. These are: Home,
Insert, Design, Transitions, Animations, Slide Show, Review and View. Each Tab is
divided into groups of related commands that are displayed on the Ribbon, For Example:
Home tab ribbon is divided into Clipboard, Slides, Font, Paragraph, Drawing, and

Editing groups.
Home l Inset  Design  Transitions  Animations  Slide Show  Review  View
& at ,ﬁ & tayout » T kv (B = iz |If Text Direction - l\\.DOD DL& O Orshaperil~ | g Find
(33 copy ~ £ Reset EJmignText * A1LLd [, shape Outline * | 3 Replace ~
e ! <f Format Painter 5?:::" aSechon BIUSd ‘AX' A A- 4 %ConventoSmanAn bé'\f\{ }?ﬁ' Alravnge ;(t]yl:‘:;k @ Shape Effects ~ RSelm'
Clipboard [F] Slides Font Paragraph I Drawing v|  Editing
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®  Outline/Slides Tabs : Outline tab displays the presentation text in the form of an
outline. This tab enables us to move slides and text by dragging selected contents.
Slide Tab displays the slides of our presentation as small thumbnails. This view also
allows easy navigation through slides.

¢  Slide Pane : It contains the current slide in our presentation. We can use the vertical
scroll bar to view other slides in the presentation.

® Notes Pane : It is located below the slide pane. This pane is used to type reference
notes about the contents of slide.

® Status Bar : It is located at the bottom of the PowerPoint window.It shows messages
and information about the view, such as the Slide Number and the Current Theme
Template used etc.

Slide 1 of 13 | “Office Theme™ g}’a English (India) g6 Bl ¥ 35% g ¥ [
i | |

®  View Options : It is located at the right side of the Status Bar. It contains buttons that
allow the ability to switch between PowerPoint views. There are four view buttons:
Normal View, Slide Sorter View, Reading View and Slide Show View. This area also
contains the Zoom feature.The Zoom control allows us to zoom-in for a closer look at
slide contents. The zoom control consists of a slider that we can slide towards left or
right to zoom in or out. We can also click on the + and - buttons to increase or decrease
the zoom factor.

4.4 HOW TO CREATE PHOTO-ALBUM PRESENTATION

We can also create photo-album presentation in the PowerPoint. PowerPoint allows us to
import a set of pictures to create a presentation of photos. With the photo album feature,we can
select, rearrange, adjust, and add text to our pictures. By default, one picture will appear on each
slide, but we can adjust the slide layout to include multiple images if we want.

To create a photo album:
i.  Click on the Insert tab
ii.  Inthe Images group, Click the Photo Album option, then select New Photo Album.

RIEY-G|-
Home Insert Design Transitions Animations
= L e (DD d
= | R G =]
Table Picture Clip Screenshot| Photo | Shapes SmartArt Chart
. Art + |abum~| -
Tables Images New Photo Album...
Slides | Outline 3E) Edit Photo Album...

A8}

Fig 4.3: New Photo Album
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iii. The Photo Album dialog box appears, as shown in the following figure:

Photo Album ? brd

Album Content
Insert picture from: Pictures in album: Preview:

Insert text:
No preview is available for this

Picture Options: selection
|| captions below ALL pictures
| ALL pictures black and white

EE = E b0 G
Album Layout
Picture layout: |F|ttoslide |V| ﬁ“'

Frame shape: |Rectangle ]VI '
Theme: | | [ Browse... |

Fig 4.4: Photo Album Dialog Box

iv. Click on the File/Disk... button. It will open the Insert New Pictures dialog box as
shown below. Select the desired image file(s). After the selection of pictures, Click the
Insert button to go back to Photo Album dialog box.

El Insert New Pictures x
« v D » ThisPC » Dump (L) » wallpapers » v O Search wallpapers el
Organize - New folder B~ O @
* Downloads A byron-johnson-2 c118701 118876 140875 ~
08842-unsplash
B Music —
=] Pictures
B videos ‘r.l_'t,'(
e Win10(C) Ei 'i:' gk
= Data (D: T .
”_' ©) 1 caleb-woods-323 casey-horner-106 christopher-jolly- chuttersnap-5892
§-h CD Drive (E) 928-unsplash 2726-unsplash 592892-unsplash 93-unsplash
= Empty (F)
- Tutorials (H:)
- Music (K)
= Dump (L)) \
cristy-zinn-58654 d17960 dallin-hassard-12 daria-sukhoruko
= Dump (L) v -unsplash 54399-unsplash va-496-unsplash |
File name: | "daria-sukhorukova-496-unsplash" "alexis-ar V| |AII Pictures V|

Tools = I Insert Ivl | Cancel l

Fig 4.5: Insert New Pictures Dialog Box

Important Tip for Picture Selection : To select all images in the folder, click on any
image and then press Ctrl + A. Doing so will select all the images in the current folder.
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We can also use Shift + Click to select adjacent images in the folder. To select multiple
non-adjacent images, press and hold the Ctrl key while clicking the desired images.

v.  The Photo Album dialog box provides several options for adjusting rotation, brightness
& contrast, changing the layout of pictures, rearranging or removing pictures as shown
in the picture below. Change these settings as required and then click on Create button
to insert pictures into the photo album.

Adjust Rotation,
Rearrange or Brightness and
Photo Album Remove Pictures  Contrastof ; x
Album Content Pictu res inAlbum
Insert picture from: Preview:
Insert text:
b355589
Mew Text Box boris-smokrovic-1394 e
brian-garcia-196959- " B
I Captions bel:o'\' ALL pictures :flgggghmn‘mssq : S
’ D: leasliides christopher-jolly-5928
Se |QGpR lﬁmﬂﬂdg and white | 10 ai::y-zimtslaﬁa-uns
| 11 ¢ d17960 4 B
Layouts on the 12 W daria-sukhoruova-45
Slides \ T Remoye | Sh| |OT(|@Y| |||l
Album Layout
| Picture layout: | Fit to side v T
F & shape Rectangle .
Theme: Browse...
Create Cancel

Fig 4.6 Settings for Photo Album

vi. Now, a separate New Presentation will be created for the photo-album. By default, it
will include a Title Page and One Picture per Slide.

Pl -0l Bresentationd - Microsoft PowePoint - 8 X
Hame Ingert Design. Transttions Animations Slide Show Review Wiew Nerefro 9 Steepboarding -3 o

= e B - i = d= b et Divectien - . ), Systage Al - !

Jj .{am Q 0 Layout T B = e \E.c Dieectian BN NOo00 @& J:»su. i 4 Find

oo JCopT - e B Reset ™ [ angn Text = AlLLd o). et [ smape Outime - | 55, Replace =

< FornatPainter | guge- ) Section BIUSd A |A-EZIE N P comenttosmatat - | % 2L} e [7] 0 Syles - = Shape Bects - | g Seledt -

Clipboard 3 shdes Font 5 Faragraph : Drawing .| Edaing
Shides | Outfine x [42 30 [ & Z1 [ENITT ITETEIEF SRTEIE: DRI LY ETIL IR TE vy |

w4

Click to add notes
Side2ot 13 | "Office Theme: | @ Engish fnesa | [EE R e el

Fig 4.7: Photo-Album Presentation
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4.5 HOW TO PLAY PRESENTATION FOR AUDIENCE?

Once our presentation is prepared, we need to learn how to present it to our audience.
PowerPoint offers several tools and features that can help make our presentation smooth, engaging,
and professional. Now, we will learn about how to present our Presentation (Photo Album
Presentation created under Heading 4.4) to audience.

PowerPoint provides many ways to play our presentation for audience. We can play our
presentation either from the very first slide of the presentation or from the current slide of the
presentation. Following discussion explains how to play presentation on the Monitor Screen or
Projector connected to our computer system:

4.5.1 How to Play Presentation from the Very First Slide

To play the presentation from the very first slide, use any of the following method:
®  Press F5 shortcut key

OR
*  Click on the Slide Show tab — Click on From Beginning (in the Start Slide Show
group)
@l HB9-0|+ Presentation2 - Microsoft PowerPoint — [m] X

Home Insert Design Transitions Animatio Slide Show Review View Nitro Pro 9 Storyboarding [A) 0
o | I b@ Play Narrations Resolution: Use Current Resolution =

Use Timings (&P Show On: -

From From Broadcast Custom Set Up Hide | Rehearse Record Slide _ ‘ - )
Beginning Current Slide  Slide Show Slide Show ~ | Slide Show Slide  Timings  Show~ Show Media Controls Use Presenter View
Start Slide Show Set Up Monitors

4.5.2 How to Play Presentation from the Current Slide
To play the presentation from the current slide, use any of the following method:
*  Press Shift + F5 shortcut key
OR

*  Using Slid Show view option available at the Status Bar

—
[EBEsE=00——608,
—
Slide Show View

OR
*  Click on the Slide Show tab — Click on From Current Slide (in the Start Slide Show
group)
Presentation2 - Microsoft PowerPoint - [m] X
Insert Design Transitions Animations S| ide Show Review View Nitro Pro 9 Storyboarding a e
= 5(:9 Play Narrations Resolution: Use Current Resolution ~
| ; Use Timings Show On: -
From From Broadcast  Custom SetUp  Hide | Rehearse Record Slide X i
Beginning Current Slide  Slide Show Slide Show = | Slide Show Slide  Timings  Show ™~ Show Media Controls | [ Use Presenter View
Start Slide Show Set Up Monitors
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4.6 SAVING AND EXITING PRESENTATION

After creating any presentation, we have to save it permanently on the secondary memory

so that we can get access to the presentation as and when required. After saving or presenting the
presentation to audience, we can close power point to release the main memory that is occupied
by the presentation. Following discussion shows how to save and close presentation in Microsoft
PowerPoint.

i.  Saving Presentation File : There are many ways to save the presentation in PowerPoint.
We can choose any one of them to save our presentation. Some of the common ways
to save the presentation are given below:

* By clicking on the File tab — Save option
OR
*  Using Save button in the Quick Access Toolbar
OR
*  Using shortcut key Ctrl + S
In Microsoft PowerPoint 2010, presentation file is saved with the .pptx extension

ii. Closing PowerPoint : PowerPoint can be closed in many ways. Anyone method can
be used to close PowerPoint. Some of the common ways to close the PowerPoint are
given below:

*  Click on File tab — Exit option
OR

®  Click on Close button (CROSS) present on the right side of the Title Bar
OR

*  Press Alt+F4 shortcut Key to close the PowerPoint

Points To Remember

A S IR O i e

—_ =
—_ O

12.

Microsoft PowerPoint is one of the major components of Microsoft Office suite.
PowerPoint is very easy-to-use presentation graphics software.

A presentation is the process of presenting a topic to an audience.

A slide is a single page of presentation.

If PowerPoint icon exists on the desktop then double click on it to Open PowerPoint.
Slide Pane contains the current slide in our presentation.

PowerPoint allows us to import a set of pictures to create a presentation of photos.
To play the presentation from the very first slide, F5 shortcut key can be used.

To play the presentation from the current slide, Shift+F5 shortcut key can be used.
In Microsoft PowerPoint 2010, presentation file is saved with the .pptx extension.
Ctrl + S shortcut key can be used to save presentation in PowerPoint

Alt + F4 shortcut key can be used to close PowerPoint
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&  ExERCSE )

Fill in the Blanks:
L. is a presentation graphics software
a)  PowerPoint b) Word
c) Excel d) Paint
I. A is the process of presenting a topic to an audience
a)  Word Processor b)  Slide
c) Presentation d) Transition
. A is a single page of presentation.
a) Slide b)  Document
c) Sheet d) None of these
IV. contains the current slide in our presentation.
a)  Outline Pane b)  Content Pane
¢) Ribbon d)  Slide Pane

Very Short Answer Type Questions

I.  How to Open PowerPoint?

II.  What is the Shortcut Key to Save the Presentation in PowerPoint?
III. What is the Shortcut Key to Close PowerPoint?

IV. What is the Shortcut Key to Start Slide Show from the first Slide?
V. What is the file extension of presentation file in PowerPoint?

VI. Which term/word is used to Open PowerPoint using RUN box?
Short Answer Type Questions

I.  What is PowerPoint?

II.  Write a short note on Presentation.

III. What is a Slide?

IV. Write the main Components of PowerPoint Window.

V. How will you play presentation for the audience in PowerPoint?
VI. Write about Slide Pane and Notes Pane in PowerPoint.

Long Answer Type Questions

I.  Explain any three components of PowerPoint Window.

II. How will you create Photo Album presentation in PowerPoint?

[CabrActivitby,

I.  Create a photo-Album presentation in PowerPoint with at least five pictures.
II. Run the slide show for the presentation of Photo Album

III. Save presentation with your name
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MICROSOFT

' CHAPTER - 5 | POWERPOINT (PART-II)

( OBJECTIVES OF THIS CHAPTER )

-

5.1 Introduction
52 How to Create a New Blank Presentation?

5.2.1  Adding Text to Slides
5.2.2  Formatting Text of a Slide
5.3  Inserting New Slide
5.3.1 How to Change the Slide Layout?

~

5.4  How to Change the Appearance of Slides?
5.4.1 Working with Themes
5.4.2  Changing Background Styles
5.4.3  Format Background

5.5 Adding Contents to a Slide (WordArt, ClipArt, Tables, SmartArt, Pictures, Movie/
Video etc.)

5.6  Slideview option in PowerPoint

-
5.1 INTRODUCTION

In the previous Chapter, we have learnt about basics of PowerPoint with the creation of

J

photo-album presentation. In this chapter, we will learn how to create a new blank presentation
using some more advanced features of PowerPoint. In slides, we can insert clipart, WordArt,
tables, pictures and videos along with text to make our presentation more effective. In this chapter,
we will also learn about how to insert new slides, how to change their layouts, different methods
to change the appearance of slides, working with views in PowerPoint etc.

5.2 HOW TO CREATE A NEW BLANK PRESENTATION?

In the previous chapter, we created a photo-album presentation in which almost all the
process is automatic and there is nothing much to do manually. Now, we will learn how to create
a presentation in which process of making presentation is defined by user. Many options are
available in Microsoft PowerPoint when we are creating a new Presentation. Following figure
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shows these options when we create a new presentation by clicking on the File tab — New
option in PowerPoint Window:

Id9-8l= Presentation - Microsoft PowerPoint = [ o
Home  Invet  Design  Tramstions  Animations  SlideShow  Rewew  View  NitmFro%  Stonbosrding = @
I soe
WTUNM“M Blank presentation
B sove s s
& o ® 4 D Home

Recent Sample Themes  Mytemplates  Newfrom

_ Office.com Templates [Search Office.com for templates |+

- Bokww2B0 o

B8 w8 @

Irveitatsons. Presentstsons. Reports mw Schedutes.

* HowwbD

z
e ai@

Fig 5.1 Creation of Blank Presentation

Whenever we start PowerPoint, it will automatically create a New Blank presentation for
us with a Single Slide (having Title Slide Layout) in it. But, if we, ourselves, want to create a
New Blank Presentation, then we can create it by using the following steps:

1. Click on File tab

2. Click on New Option

3. Click on Blank Presentation

4. Click on Create button

| H9-0]|= Presentation] - Microsaft PowerPoint = 1) i
Home Ingert Design  Transtions  Animations  Slige Show Review  View N Prod  Stoyboarding o @)
X out i Layout - AN B = | 11 Text Direction - B~ 000 - %é S shape Fin - 34 Find
[ Copy = BpReset . [HangnTea - AlL o~ 2 snape Qutline = | 33, Replace =

Pl o fomstpainter | hgee seion- [ B £ U S par A EXE AW (W peaosmua- |8 3 O e G shaps Bects | [y select =
Paragraph 5 n
e

Click to add title

Click to add subtitle

Fig 5.2 Blank Presentation
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We can also create a blank presentation by just pressing the Ctrl + N shortcut key. Following
window will appear whenever we create a new blank presentation in Microsoft PowerPoint
2010:

5.2.1 Adding Text to Slides

In the Blank Presentation, a slide with white background andtwo placeholders - one for the Title
and other for the Subtitle will appear as shown below. Placeholders are the dotted-line containers
on slide layouts that hold contents such as: titles, subtitles, tables, charts, SmartArt graphics,
pictures, clip art, videos, and sounds.

Click to add title

Click to add subtitle

Fig 5.3: Slide with Title and Subtitle

To add text in either of these placeholders, we have to click in it. Now, a blinking cursor
will appear in the placeholder to type text in it. After typing text in the placeholder, just click
outside the textbox so that blinking cursor disappears from the Textbox.

If we need to add text to a slide outside of the normal text placeholders, we can add a text box on
the slide. To do this, perform the following steps:

*  Click on Insert tab

*  Click on Text Box option in the Text group.

*  Now, draw the textbox on the slide by dragging the mouse.

* A blinking cursor will automatically appear in the box to start typing.

We can also move, resize and rotate these textboxes. To move it at some other location on
the slide, just click at its border and drag it to some new location on the slide. To resize a text
box, click and drag on any of the handles that appear at corners and halfway along each edge. To
rotate a text box, click on the green rotate handle at the top of the box and drag it in left or right
direction.
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ile Qesig il Review View Mitro Pro 9 Storyboarding Format |

A8 433849 TCQ@@

Text Header WordArt Date  Slide Object = Equation Symbol | Video Audio
~ Art s Album ~ . Box & Footer = & Time Number - " =

Tables Images lllustrations Text
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Fig 5.4: Inserting Textbox

5.2.2 Formatting Text of a Slide

We can also format text added to placeholder/textboxes in the similar way as we do it in
Microsoft Word. We can apply standard text formatting using the Font and paragraph groups
on the Home tab.

Il Preventation] - Microsoft PowerPont m - =] ®
Home | dnwet  Design  Tranaitions  Animations  StideShow  Revew  View  ltiofrof Ronboarding | Format & @)

= |1 Text Dwection = By shape Fal =
[u i (B 112 mm:- s Eu.-boa- gy ﬁzmm

B 1A B0 -] Oﬂmm
m fa

. |

%
i

1
|

&

e o i e e a5,

Fig 5.5: Formatting Text of Slide

To apply formatting, first of all we have to select the text in the placeholder on which we
want to apply formatting, then select the appropriate options such as: Font, Bold, Italic, Underline,
Text Shadow, Strikethrough, Font Colour, Font Size, Change Case, and Alignments etc. in the
Font and Paragraph groups of Home tab.

44 COMPUTER SCIENCE



5.3 INSERTING NEW SLIDE

After adding the Title and Subtitle of our presentation on the first slide, we can add more
slides to our presentation. During the insertion of a new slide, we have to determine which
placeholders to appear on it. It is the slide layout that determines which placeholders will appear
on the new slide. We can use the following steps to insert a new slide:

I.  From the Home tab, click the bottom ( v ) half of the New Slide command to open the
menu of slide layout options.

II. Select the slide we want to insert.

III. A new slide will be added to our presentation.

PllE2-0|= Presentation] = Microsoft PowerPaint - o x
Home | Inset  Design  Transitions Animations Slide Show  Review  View  MNaroFro9  Storyboarding o @)
cut i | Layout - . o == 2 = lIf} Text Direction - . ) rshaperan- Find

0o (5| R N L B NNOoOo- Hy ) ¢ "

oo Ga Copy * Reset Y 5] align Test = ALL GO~ - & shape Outline - | %5, Replace +
" - . g . . - 3 L

2 Format painter | |gyge | section | B T U Sdii-m (A EFIE M B comventto smanart - | | % VAL T oy 7|V g?:ill; o snapeEtrects - | [ selea~

Chiphoar d | | Office Theme L= Faragraph g Drawing . Editing
E
T R e 4-!-3'I'Z-I-I'I'D'I'I-I'Z-l-jll'4-l-i-l-ﬁ-l‘?-IG-I-Q'\'].DI'll-I-lZ-II

Title Shde Section Header

Twa Content Comparison Title Oty |

..... Hill 2
Bank Content with Ficture with BE (;-.
pppppp i (2] EL] 55
{3 Duplicate Selected Stides =
5 siides from Qutiine... i
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:
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| Stide2 etz | "Office Theme" | & English fndia) | [Ezwg s C—U——®0
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Fig 5.6: Insert a New Slide
To instantly add a slide that uses the same layout as the one we have selected, click the top
half of the New Slide command or press shortcut key Ctrl + M from keyboard.
5.3.1 How to Change the Slide Layout?

A Slide Layout defines the design and placement of different elements on a slide.If we
want to draw a chart on a slide, we have to select a slide layout that provides a convenient way to
add chart to the slide. We can select the Slide Layout during insertion of new slide. However, we
can also change the slide layout after the slide has been inserted in the presentation.To change
the layout of the slides, we can follow the steps as given below:

I.  Select the slide whose layout we want to change.
II. In the Home tab, click on the Layout drop-down menu, located in the Slides group.

III. Select the layout that suits our requirements.
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Fig 5.7: Slide Layout

5.4 HOW TO CHANGE THE APPEARANCE OF SLIDES?

Whenever we start PowerPoint, we may typically see a single slide with a white background.
Sometimes, we need to change the appearance of our slides to improve the look and feel of our
slides. PowerPoint provides us the facility to change the complete appearance of slide by changing
the background-design, colour-scheme, background-colour, texture, pattern and gradient. In
PowerPoint 2010, Design tab helps us to easily modify and customize our slides’ theme,
background, and more.

5.4.1 Working with Themes

A theme is a predefined set of colours, fonts, and visual effects that we apply to our slides
for a unified, professional look.Themes help us to create content that looks attractive and consistent
while avoiding lots of manual formatting. Following steps can be used to apply themes to our
current presentation:

I.  Click on the Design tab and find design themes in the Themes group.

II. To preview how the current slide would look with a particular theme, hover the mouse

pointer over the thumbnail image of that theme.

ITII. To view more themes, on the Design tab, click on “More” button at the right-bottom

end of the gallery.
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IV. To select and apply a theme, click the thumbnail image of that theme.

V. Unless we specify otherwise, PowerPoint applies the selected theme to the entire
presentation.

VI. To apply a theme to only one or a few slides, select the slide or slides, right-click the
theme we want, and select Apply to Selected Slides.
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El ﬁ Aa Ra Aa Aa Aa - [EFonts~ oA o B
m; Omn;em _._ masmmn = [Gtects - [0 Hige Backgreund Graphics
Page Setup Themes Batkground W
Hides | Outline O P S N T S S E T e ZX0 U T U I, S S S LXL BN XL XL VIR F |
1 = p— -
H
Computer System @
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o
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Fig 5.8 Themes

5.4.2 Changing Background Styles

PowerPoint backgrounds are images or design elements that are placed on our slides behind
whatever text, charts, images, or other objects we are presenting on the slides.Background styles
can be added to our slides after a theme is applied. These styles are fill-variations based on
theme colours. When we switch to a different theme, the background styles are updated based on
the new theme colours.

In PowerPoint, we can add a background style to our presentation. There are 12 default
slide Background Styles available in PowerPoint 2010. In the following discussion, we will
learn how to apply the background styles of slides in PowerPoint:

I.  Click on Design tab
II.  Click on the Background Styles button in Background group.

III. Background Styles drop-down gallery will open which shows 12 predefined
background styles as shown in the figure 5.9. Click a style to select it. The new
background will appear on the slides.
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Figure 5.9: Background Styles gallery and Format Background option

5.4.3 Format Background

Beyond the Background Styles, we can also change the default background to a solid
colour, a gradient, a picture or texture, or even a pattern.For this purpose, we have to use the
Format Background dialog box. To open the Format Background dialog box, perform the
following steps:

Click Design tab — Background Styles in Background group — Format Background...

Following Format Background dialog will appear:

Format Background 7] *
Fil J| [ Fin
Picture Corrections | | (@ Solid fill
Picture Color O gradient fil
Artiatic Effects O Ppicture or texture fill
O Pattern fil
[ Hide background graphics
Fill Color
ger
Transparency: [
ResetBackground | | Clese | | Applytoal |

Figure 5.10: Format Background dialog box
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Two panes are present in this dialog box. Left pane shows 4 options: Fill, Picture Corrections,
Picture Color, and Artistic Effects. First option - “Fill” is used to format the background of
slides while other options - Picture Corrections, Picture Color, Artistic Effects, are used to format
the background picture (if we use Picture as a Background on the slides). The options within the
Format Background dialog box under Fill panel are explained below:

i

ii.

Solid Fill : This option is used to add a solid colour background to our slide. We can
use any of the Theme colours, Standard colours, or any other colour of our choice. To
fill a solid colour, click the Color button to open the Color drop-down gallery. The
options in this gallery are:

Automatic : This option is used to set the default background colour of the Theme
applied to the presentation.

ThemeColors : This option is used to select any of the colors which are from the
active Theme of the presentation.

Standard Colors : This option is used to choose a color from any of the ten standard
colors. These ten standard colors are just choices of colors that PowerPoint believes to
be widely used.

Recent Colors : This option is used to select a color from the list of most recently
used colors.

More Colors : This option is used to open the Colors dialog box, which helps us to
create our own new color to use as a background fill.

Format Background ? %
2 Fill
Picture Corrections | | @ Solid fil
Picture Color QO Gradient fil
Artistic Effects Q Picture or texture fil
QO Pattern fil
[ Hide background graphics
Fill Color
Color: & -
Transpa|  Automatic ]
Theme Colors

H EEENEEMN

e
Hliillllll
Standard Colors

HET FEEEEN
Recent Colors

|

43) More Colors...

I Resetgadcground ] l Close ] I Apply to All

Fig 5.11: Fill Options-Solid Fill

Gradient Fill : A gradient is a blend of two or more colours merging into each other.
Gradient Fill option is used to apply a gradient as a slide background. On Clicking the
Gradient Fill radio button, we can see many options to format background with the
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Gradient. Preset colors include a gallery of several ready to use default gradients that
we can select for our slide background. Other options under Gradient Fill can be used
to adjust the settings for Gradient.

Format Background

Picture Corrections
Picture Color
Artistic Effects

[

Fill
O solid fil
@ Gradient fil

O Pattern fill

O Picture or texture fil

[0 Hide background graphics

S——

-, RN =

Direction:

v e O

Gradient stops
=] Il
oy |- =
Brightness: [Gold 1]
1=

| Rotate pith srape

| ResetBackground | | Close | [ appytoan |

Fig 5.12: Fill Options-Gradient Fill

iii. Picture or Texture Fill : It allows us to use a picture or a texture as a background.
When we click on the Picture or texture fill radio button, it will display many options
to fill the slide background with the texture or picture.

50

Clicking on Texture button will show Texture drop-down gallery as shown in the
following figure. Choose from any of these readymade textures to change the slide

background.

Forrnat Background

[Fa

Picture Corrections
Picture Celor
Artistic Effects

Fill

Q) Solid fill

O cradient fil

(® Picture or texture fil

O Ppattern fil

[0 tide badkground graphics
Textwe: | ~

Insert fron]
(A Tie pic| |
Tiling optiof
Offsetx]
Offaet v{ B¢
Alignmen| Mg B
Mirror tyy W
Transparer)
[ Rotate

Fig 5.13: Fill Options-Picture or Texture Fill
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If we want to use any other picture as a texture, then click on the File... button under
the Insert From section. Clicking the File... button brings up the Insert Picture
dialog box. Navigate to where we have some pictures saved, after selecting the picture,
click the Insert button in the dialog box.

iv. Pattern Fill : Patterns in PowerPoint are two-color designs. These designscomprise
of lines, dots, dashes, checks, etc. PowerPoint includes 48 such patterns with names
like plaid, weaves, shingle and zigzag etc. We can choose any from these patterns to
apply at the slide background. To change the foreground or background colors of
these patterns, we can use Foreground Colors and Background Colors galleries
which are present below these patterns.

Format Background

]
Picture Corrections

Picture Color
Artistic Effects

Fill

O sold fil

O Gradient fil

(O Ppicture or texture fil

(® Pattern fill

[ Hide backaround araphics

V=

2 BN |

NI S

1T k=
wmy =

Foreground Color:
Background Color:

| Reset Backaground | I Close

Apply to All

Fig 5.14: Fill Options-Pattern Fill

Select any of the Format Background options explained in this section. Thereafter, to apply
the selected format to the background of our slides, either click on “Close” or “Apply to All”
button. By Clicking on Close button, we can format the background of selected slides in the
presentation. If we don't have multiple slides selected, then the formatting selection of background
will be applied to the active slide only. Clicking on “Apply to All" button will fill all slides in the
presentation with the selected formats.

If our slide background includes graphics which we want to hide for printing purposes, or
another reason, we can select Hide Background Graphics check box in the Format Background
dialog box. Although the background graphics will remain part of our presentation, it will be

hidden from view.

Tip : The “Hide Background Graphics” check box is also available under the Background

Styles button on the Design tab.
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If we want to abandon all the changes that we made to the slide background, click the
Reset Background button. Note that this button will be greyed out unless we make some changes
to the slide background.

5.5 ADDING CONTENTS TO A SLIDE (WORDART, CLIPART, SHAPES,
TABLES, SMARTART, PICTURES, MOVIE / VIDEO etc.)

The presentation slides contain the information that we want to communicate with our
audience. This information can include text, pictures, charts, video, and sound.

Adding Graphics will help make our presentation more presentable for viewing by making
it more interesting. [fwe are presenting numbers, statistics, or other data then it would be convenient
to represent such numbers/data in the form of charts or tables. Shapes are a way to add creativity
to our project. Shapes allow us to separate our designs into boxes, circles, and other interesting
formats to make our presentation more exciting. ClipArt is an excellent way to make our project
more appealing to our audience.

To add these contents to our slides, we can use appropriate options available in Tables,
Images, Illustrations and Media groups of Insert tab. These options work in the same way as
we do in Microsoft Word. So, we are not going to discuss these options individually in detail as
we have learnt about them in your previous class.

2 BRI

Presentationl - Microsoft PowerPoint

Design Transitions Animations Slide Show Review View Nitro Pro 9 Storyboarding

......

HHB - PRl QU EEAEEE T Q&Y

Table | Picture Clip Screenshot Photo | Shapes SmartArt Chart Text Header WordArt Date  Slide Object Video Audio
v v Album ¥ M Box & Footer ~ & Time Number \J J

Text

Hyperlink Action Equation Symbol

v

Tables Images lllustrations Links

Symbols Media |

Fig 5.15: Options of Insert Tab

There is one other way to insert graphics, tables, shapes etc. into our presentation slides.
Many slides have a set of 6 icons in the Content Placeholders as shown in the following diagram.
These icons can be used to insert Tables, Chart, SmartArt Graphics, Picture from File, Clipart,
and Media Clip. Clicking on appropriate icon will open/show options for the insertion of respective

Objects in the slide. Title Placeholder

/.
¥

Click to add title

* Click to add text

Insert Chart
Insert Table

; -t Insert SmartArt
B2« Graphics
/ \ o .
Insert Picture from File Insert Media Clip

Insert Clip Art

/

Conten’t Placeholder

Fig 516: Slide with Title and Contents Layout
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When we add graphics to a slide, we may need to resize them to another location. To resize
a graphic image, PowerPoint displays handles around our selected object. Move the mouse pointer
over a handle. The mouse pointer turns into a two-way pointing arrow. Hold down the left mouse
button and drag (move) the mouse. PowerPoint resizes our selected graphic image. Release the
left mouse button when we are happy with the new size of our graphic image. We can also rotate
graphics with the help of a green rotate handle that appears on the selected graphics. To delete
any graphics, just select the graphics by clicking on it and then press the Delete button from the
keyboard.

5.6 SLIDEVIEW OPTIONS IN POWERPOINT

Status bar contains view options that allow the ability to switch between PowerPoint views.
It is important to be able to access the different slide views and use them for various tasks. There
are four view buttons (Normal View, Slide Sorter View, Reading View and Slide Show) along
with the Zoom slider on the status bar as shown in the following figure. These view options are
located on the bottom-right of the PowerPoint window in Normal view.

Reading View

Slide Sorter View
Slid Show Zoom Slider

_/
Normal View oo Bl & 66% @ LB @

Fig 5.17: View Options in Status Bar
A brief description of these views is given below:

®* Normal view : This is the default view where we create, edit and design our
slides. This view has 3 working areas: left area (having slide/outline tabs), right area
(having slide pane) and the bottom area (having notes pane). We can also move slides
in the Slides tab pane on the left area of this view. If we want to delete a slide, just
click on the slide that we want to delete in the left area and press Delete key from the
keyboard.

® Slide Sorter view : This view represents the presentation slides in thumbnail form.
Slide Sorter View gives an overall picture of presentation making it easy to reorder,
add, or delete slides.

® Reading view : This view fills most of the computer screen with a preview of our
presentation. This view shows some easily accessible buttons for navigation, which
are located at the bottom-right of the screen.

¢  Slide Show view : We use Slide Show view to deliver our presentation to our audience.
Slide Show view has an additional menu that appears when you hover over it. This
menu allows us to navigate slides and access other features that we can use during a
presentation.
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Zoom Slider : It is located at the right side of the Status Bar. The Zoom control allows
us to zoom-in for a closer look at slide contents. The zoom control consists of a slider
that we can slide towards left or right to zoom in or out. We can also click on the + and
- buttons to increase or decrease the zoom factor.

Points To Remember

1.
2.

9.

We can also create a blank presentation by just pressing the Ctrl + N shortcut key

Placeholders are the dotted-line containers on slide layouts that hold contents such as:
titles, subtitles, tables, charts, SmartArt graphics, pictures, clip art, videos, and sounds.

To instantly add a slide that uses the same layout as the one we have selected, press
shortcut key Ctrl + M from keyboard.

A Slide Layout defines the design and placement of different elements on a slide.

A theme is a predefined set of colours, fonts, and visual effects that we apply to our
slides for a unified, professional look.

There are 12 default slide Background Styles available in PowerPoint 2010.
A gradient is a blend of two or more colours merging into each other.

Patterns in PowerPoint are two-color designs which comprises of lines, dots, dashes,
checks, etc.

Normal view is the default view where we create, edit and design our slides.

10. We use Slide Show view to deliver our presentation to an audience.

@ﬁj EXERCISE )

1.  Multiple Choice Questions:

1.

11.

1il.

1v.

54

A defines the design and placement of different elements on a slide.
a)  Background Style b)  Place holder
¢) Slide Layout d) Pattern
A is a blend of two or more colours merging into each other
a) Theme b)  Pattern
c¢) Background Style d)  Gradient

is the default view where we create, edit and design our slides.
a)  Normal view b)  Slide Show
c¢) Slide Sorter View d) Reading View
Thereare  default slide-background styles available in PowerPoint 2010.
a) 48 b) 4
c) 12 d 3
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II.

I1I.
IV.

V.

V.

The control allows us to zoom-in for a closer look at slide contents.
a) Zoom b) Slide
b) Normal View d)  Gradient

Very Short Answer Type Questions

L.
II.

I1I.
IV.

V.

What is the Shortcut Key to Insert a New Slide?

What is the shortcut key to Create a New Presentation?

Which tab is used to format text on the slide?

Which PowerPoint view is used to deliver our presentation to our audience?

Which bar contains the View buttons and Zoom Slider in PowerPoint?

Short Answer Type Questions

L.
II.

I1I.
IV.

V.

VL

Write the steps to create a new presentation using File tab in PowerPoint.
What are Placeholders?
What are Themes?

Write the names of different view buttons available at the status bar of PowerPoint
window.

What is Gradient Fill?

Which options are available in the Fill pane of the Format Background dialog box?

Long Answer Type Questions

L.
II.

III.

Explain briefly about the different methods to change the appearance of slides.
What is Slide Layout? How will you change it in PowerPoint?

Write about the Slide View options in PowerPoint.

[CabrActivitby,

ACTIVITY -1

Create a New blank presentation having at least 5 slides.

First slide : slide related to your School name

Second Slide : about infrastructure

Third Slide : About Computer lab

Fourth Slide : About Teachers

Fifth Slide : Best Thing about your school

Format the Background of all slides with the Gradient Fill

Insert at least one picture in two slides from clip art gallery

Save it with your roll no

Run the Slide Show to present it to other students of your class
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ACTIVITY -11

I.  Create a New blank presentation having at least 5 slides explaining the topic of your own
choice.

II.  Apply Theme of your choice to this presentation
III. Try changing the order of Slides in your presentation
IV. Save it with your name and roll no

V.  Run the Slide Show to present it to other students of your class
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CHAPTER - 6 POWERPOINT (PART-III)

( OBJECTIVES OF THIS CHAPTER )

(1111

4 )
6.1  Introduction
6.2  Working with Transition
6.3  Working with Animation
6.3.1 How to Apply Animation?
6.3.2  Working with Animation Options
6.4  Narration and Timings
N 6.5 Save Presentation as... y

6.1 INTRODUCTION

In the previous Chapter, we have learnt about some basics and advanced options of
PowerPoint. In this chapter, we will learn some more advanced features of PowerPoint such as
adding Transition and Animation Effects, how to add narration, and how to save presentation in
other formats.

6.2 WORKING WITH TRANSITION

A slide transition is the visual and motion effect that occurs when we move from one slide
to the next slide during a presentation. We can control the speed, add sound, and customize the
look of transition effects. Following are the steps to apply Transition in the presentation:

1. Select the slide we want to add a transition to

2. Click on the Transitions tab and select a transition from the “Transition to This Slide”
group.

3. Set other options such as Effect Options, Sound, and Duration etc. according to our
requirement.

4. Select Preview to see what the transition looks like

If we want to apply the same transition on all slides in the presentation, then click
“Apply To All” in the Timing group.
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Preview | Transition to This Slide Timing

Fig 6.1: Transitions Tab

We can also remove the transition effect that has been applied on the slides by clicking on
None in the Transitions tab. (in Transition to this Slide group)

Following are some additional settings that can be set for Transition Effects in PowerPoint:

* Effect Options : This option is present in the “Transition to This Slide”” group of
Transition tab after the transition gallery. This option is used to change how the
transition occurs. It allows us to change the direction or other options of the effect.

¢  Sound : This option is present in the “Timing”’ group of Transition tab. It allows us
to set a sound on each transition.

i\ sound: [NoSound] -
© Duration: 0200

Effect
Options ~ ' EAPDIyTo All

Timing

®  Duration : This option is also present in the “Timing” group of Transition tab. It
allows us to increase or decrease the duration or time of the effect. We can set a time
in Duration option to set how fast the transition goes.

We can apply these settings to our presentation according to the requirements and thus
make our presentation more effective.

6.3 WORKING WITH ANIMATION

Animations are visual effects that display movement on the objects in the presentation.
These slide objects can be anything such as: text, pictures, charts, SmartArt graphics, shapes,
even movie clips etc. Animation can help make a PowerPoint presentation more dynamic.
PowerPoint provides following four types of animations:

i. Entrance : An Entrance animation determines the manner in which an object appears
on a slide; for example, an object can move onto a slide.

ii. Emphasis: An Emphasis animation does something to draw attention to an object; for
example, the object can become larger.

iii. Exit : An Exit animation determines the manner in which an object leaves a slide; for
example, an object can move off a slide.

iv. Motion Paths : A Motion Path animation determines how an object moves around a
slide; for example, an object can move from left to right.
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Fig 6.2: Types of Animations in PowerPoint

6.3.1 How to Apply Animation?

PowerPoint provides predefined collection of animation effects. This collection of animation
effects is also known as Animation Schemes. We can apply these predefined visual effects to
slide objects with a single click. Following are the steps to apply these animation effects on the
slide objects:

1. Click on the Animation tab

2. Select the object on which we want to apply animation scheme.

3. Inthe Animation group, click the More arrow button to view the available animations.
4

Select the desired animation effect, for example: Appear or Fade or Fly In etc., that we
want to apply on the selected object.

PllH9- -0+  Computer System - Microsoft PowerPoint {.. llL._:‘ = X
Home  Inset  Design  Tansons | Ammations | SideShow  Review  View  NitmPoS  Stopboarding Format o @
. = ) i » ] o= ‘animationPane b Start On Click ¥ | Reorder Animation
ﬁ k * 3* Y bl » * * B - i F Trigger = © Duration: 0050 || 4 Move Earlier
Prediew Hone Agpear Fade Fiyln Fioatin Split Wipe Shape wheel [o] B | aimeion Y Anmation Pointer | 3 Delay. 0000 5| v Movelater
resew Anmation 5| Aceneosnmtion | timing
Siides | Outline x [ e | \e e [ e 2
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" Hi More
Computer System H Button
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Fig 6.3: PowerPoint Window with Animation Tab
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6.3.2 Working with Animation Options

We can customize the animations effects applied on the slide objects such as increase or
decrease the speed of moving objects, duration of effect, delay in effect, change the order to
animation etc. To customize such animation effects, we have to modify the values of options

available in the Animation tab. Some of commonly used options to customize the animation
effects on the slide are explained below:

»

Preview

Home Insert Design Transitions Animations Slide Show Review View
ks - = ag Animation Pane b Start: | On Click ~ | Reorder Animation
k * k v‘ T 7 Trigger - © Duration: 0050 3 || 4 Move Earlier
None Appear 2de »71‘ O:gz:s - Anir:adtci'on - %Animation Painter | @ Delay: 0000 T ¥ Move Later
Animation ] Advanced Animation Timing

Preview

60

Fig 6.4: Animation Tab

Effect Options : Some animation effects will have options
that we can change. There will be different Effect Options

depending on the animation we choose for the object.For 0:;1::;
example, with the Fly-In effect, we can control which i

direction the object comes from.Similarly, with the — hetnenied
“Appear” effect on the bulleted list, we can control the i

sequence of list items, i.e.we can set whether the text appears s AllatOnce

as one object, all at once, or by paragraph. We can access the

Effect Option by selecting Effect Options on the Animation E PecagrEh

tab ribbon.

Add Animation : We can also apply more than one animation effects on a single
object. The same slide object can have all four animation types added to it and set to
play one after the other.To apply multiple
animations, select the object and then click the Add # =3y Animation Pane
Animation button to display the animation effects.

; Trigger
Just as we did with the first effect, we can hover Add - L
Animation +| ®5 Animation Painter

over to get a live preview. Click to apply the effect. e

The animation effects will play in the order they
are applied.

Animation Pane : The Animation pane allows us to view and manage all of the
effects that are on the current slide. We can modify and reorder effects directly from
the Animation pane, which is especially useful when we have several effects.To open
the Animation pane, perform the following steps:

From the Animations tab, click the Animation Pane command.

li =0 Anirﬁtion Pane

w; Trigger ~
Add - :
Animation ~ %% Animation Painter
Advanced Animation
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ii. The Animation Pane will open on the right side of the window as shown in the following
figure. It will show all of the effects for the current slide in the order they will appear
during slide show.

Pl 9~ 3|+ Computer Systern - Microsoft PowerPaint - O X
:' Flel| Home  Insert  Design  Transitions | Animations | Slide Show  Review  View

b ‘ L e 'i i20 Animation Panel b Start: | On Click = | Reorder Animation
k * * - N 7 Trigger = © Duration: || & Move Earlier
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e':lew None Multiple Appear 171 Opti:ns' Animation = *\}ﬂnimation Painter | @ Delay: 00.00 | * Move Later
Preview Animation [ Advanced Animation | Timing
:l = » |I12||l10|||3|||6|||4|||2|||0|||2|||4|||6|||B|||10|||12' Animation Pane w X
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#| = I
w
E 13 Title 1: Compu...|[]
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Fig 6.5: Multiple Animations and Animation Pane with Timeline

We can reorder the sequence of animation effects of slide objects from the Animation Pane using
the following steps:

I.  On the Animation Pane, click and drag an effect up or down

II. The effect will get reordered.
We can preview the animation effects of slide objects from the Animation pane using the following
steps:

I.  From the Animation pane, click the Play button.

II. The effects for the current slide will play. On the right side of the Animation pane, we
will be able to see a timeline that shows the progress through each effect. If the timeline
is not visible, click the drop-down arrow for an effect, then select Show Advanced
Timeline.

* Animation Painter : This option is used to copy animation effect. Sometimes we
may want to apply the same effects to more than one object. We can do this by copying
the animation effects from one object to another using the Animation Painter. Following

are the steps to do so :
# *30 Animation Pane

;; Trigger ~
Add

Animation * 1k,o)!\rﬁnation Painter
Advanced Afimation
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II.

I1I.

II.

I1I.

IV.

-

Home Insert Design Transitions IAnimatians I Slide Show Review

*

Preview

Click the object whose effects we want to copy

From the Animations tab, click the Animation Painter command.

Click the object we want to copy the effects to. The effects will be applied to the
object.

Timing Effects : Timing group of Animation tab provides options for when to start
animation, duration of animation effect, delay time and Reordering options of animation
effects.To change/adjust the value of any option in this group, first of all select the
effect in the Animation Pane and then set the value of that option.

p Start: On Click ~ Reorder Animation
@© Duration: 00.50 & Move Earlier

@ Delay: 00.00 ¥ Move Later

Using Start option, we can change when our animation starts to play. By default, it is
On Click. Choose one of the options from the Start dropdown list:

. On Click : 1t starts the animation when we press the left click button of the
mouse.

P Start: On Click Izl

© Durati On Click
® Delay: With Previous
After Previous

v

. With Previous : It starts animation of object at the same time as the previous
animation begins.

. After Previous : It starts animation when previous animation ends.

Using Duration option, we can also set/edit the time duration that the animation

plays.

We can also set the time Delay for the animation effects by setting the time whatever

we want.

We can change the order in which the animation effects are applied by clicking Move

Earlier or Move Later.

Previewing Animations : Click on the Preview button in Preview group of Animations

tab at any time to test how our animations look.We can also select the Play button on

the Animation Pane to preview the Animation effect.

#IJ

Kk Kk T . G 1 ¢

None Appear Fade Fly In Float In Split

Preview

Animation
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6.4 RECORD SLIDE SHOW (NARRATION AND TIMINGS)

Record Slide Show is a very useful feature of PowerPoint. This feature is similar to the
Rehearse Timing feature, but it's more comprehensive.If we have a sound card, microphone, and

speakers, and (optionally) a webcam, we can record our PowerPoint presentation. During this

recording, we can capture narrations and slide timings. After recording narration, it can be played
for our audience in Slide Show or we can save the presentation as a video file. Such recorded

presentations are very useful if we are planning on using our slide show for a self-running

presentation.

Adding narration to PowerPoint presentations is very easy. Following are the steps to record

slide show with narration and timing in PowerPoint 2010:
i.  Click the "Slide Show' tab on the ribbon.
ii.  Click the "Record Slide Show'' drop-down arrow in the Setup group.

iii.  Select either Start Recording from Beginning or Start Recording from Current Slide.
The Record Slide Show dialog box will appear.

Computer Systern - Microsoft PowerPoint

PllH9- 0~
: File Home Insert  Design  Transitions  Animations | Slide Show | Review  View  NitroPro9  Storyboarding

P Y BT &

From From Broadcast  Custom SetUp  Hide
Beginning Current Slide  Slide Show Slide Show = | Slide Show  Slide

Start Slide Show

Rehearse
Timings

}3 Play Narrations Resolution: Use Current Resolution =
e Use Timings I_'é,_l‘ Show On: -
Show = Show Media Controls | [] Use Presenter View
K9  Start Recording from Beginning... Monitors

Slides | Outline | *

o
xr

Computer System
e Dctromic Device fox %
Processing Dats

o4

)
r

kD Start Recording from Current Slide...

Clear

s N R R S R L A

3

Fig 6.6: Record Slide Show

iv. Choose what we would like to record by clicking on the appropriate check boxes
(Slide and animation timings and/or Narrations and laser pointer) and click ''Start
Recording”. (Remember, we can only record narration only if we have a microphone

attached to our computer.)

>
Record Slide Show

(2 [

Select what you want to record before you begin recording.
Slide and animation timings
Narrations and laser pointer

[ Start Recording ] I Cancel ]

v.  Our presentation will open up to a full-screen view. Play the slide show of our

presentation. If we are recording narration, Make sure to speak clearly into the

MicrosortT POwERPOINT (PART-III)
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microphone. When we are ready to move to the next slide, click the Next button on the
Recording Toolbar in the top-left corner, or use the right arrow key from keyboard.

Recording w
% 0 0:00:02 © 0:00:02

vi. We can also pause recording of our slide show using the Pause Recording button
available on the Recording Toolbar and can view the time duration of Recording.

vii. When we reach the end of the show, press the Esc key to exit.

viii. Our slide show timings and narration are now included in our presentation. The slides
with narration will be marked with a speaker icon at the bottom-right corner of the
slide.

ix. We may now play our presentation and see the recorded narrations in the self-running

presentation.

6.4.1 How to Remove Narration or Timings from a Recorded Slide Show
i.  Click the Slide Show tab
ii.  Click the Record Slide Show drop-down arrow in the Set Up group.
iii.  Click/Hover on Clear option to open submenu.

1v.

i
5 ¥ B O

From From Broadcast  Custom SetUp  Hide
EBeginning Current Slide  Slide Show Slide Show = | Slide Show  Slide

Select the option as per the requirement.

0=

Home

Computer System - Microsoft PowerPoint

Insert Animations [ SlideShowl Review

&0

Rehearse [Record Slide
Timings Show =

Design Transitions View Nitro Pro 9 Storyboarding

PFlay Narrations
Use Timings
Show Media Contrals

Resolution: | Use Current Resolution -~
[ Show On; .
[ use Presenter View

Start Slide Show K3 Start Recording from Beginning... Manitars
W3 Start Recording from Current Slide...
Components of Compy — ’
Clear L4 Clear Timing on Current Slide

* Hardware * Clear Timings on All Slides
Computer System e

* Software Clear Narration on Current Slide
An Electronic Device for Clear Narrations on All Slides

Processing Data
4 4
r 00:03 1 ¥ 00:02 2

Fig 6.7: Clear Timings on Slides

6.5 SAVE PRESENTATION AS...

We have learnt about saving the PowerPoint presentation file with .pptx extension. Besides
this, a presentation file can be saved in several other formats. To save a presentation file in other
formats, we have to use the Save As... dialog box which can be opened by File — Save As
option. Following discussion shows how we can save our presentation file in other common
formats using PowerPoint 2010:
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6.5.1 Save Presentation in PDF format

Saving our PowerPoint presentation as a PDF (Portable Document Format) file is a quick
way to produce a PowerPoint presentation that is ready for printing, reviewing, or emailing. The
biggest advantage of saving a presentation in PDF is that recipients won't be able to edit our
presentation contents. Following are the steps to save the presentation slides in the PDF format:

1. Click on File tab

ii. Click on Save As option

[B] Save As e
ki @ « Users » Kansal » Documents » w O Search Docurmnents 2
Organize = MNew folder E= - e
= This PC ta Mame - Date modified Type
:i 3D Objects |_ Files for Movie Maker 03-06-2020 10:58 File folder
[ Desktop (&) My Data Sources 06-06-2020 11:13 File folder
[ Documents | | Sound recordings 21-02-2020 10:32 File folder
.‘. Downioad [ visual Studio 2015 06-09-2020 17:44 File folder
ownloads p—
) | Weondershare Filmora 18-05-2020 14:47 File folder
d Music ) €S Al Video Lecture Links 10-05-2020 18:58 Adobe Acrobat D...
=] Pictures
B videos
. Win10 (C:) o 2l =
File name: | Computer Systern V|
(Sm as type: |PDF v)
Authors:  Kansal Tags: Add atag
| Options... - St.!|_1dar\d (publizhing
- — online and printing)
[ Open file after publishing () Minirum size
(publishing online)
» Hide Folders Tools = I Save | I Cancel |

Fig 6.8: Save As dialog box — Saving presentation in PDF Format

iii.  Select a location and type the name for the file.
iv. Select the ““Save as type” drop down arrow and choose PDF (*pdf)
v.  Click on Save button to create PDF file

6.5.2 Save Presentation as a Video:

One of the new features in PowerPoint 2010 helps us to create a video with just a
click. After we have created our slides and record timing and narrations that we want to include

in our video, we're ready to create a video file. Following are the steps to save a presentation as
a Video:

i.  Click on File tab

ii.  Click on Save As option
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(P] save As X
4 « Users » Kansal » Documents » v Search Documents o
Organize ~ Mew folder == v e
= This PC Marne Date modified Type
j 3D Objects : Files for Movie Maker 03-06-2020 10:58 File folder
I Desktop (E) My Data Sources 06-06-2020 11:13 File folder
Documents _ Sound recordings 21-08-2020 1032 File folder
“ Bownload __ Visual Studio 2015 06-09-2020 17:44 File folder
ownloads 1
w_ | | Wondershare Filmora 18-05-2020 14:47 File folder
& Music Computer Systern 08-09-202016:22 WMV File
=] Pictures
E Videos
G Win10(C:) v £ 3
File name: | Cornputer Systermn -
(Save as type: | Windows Media Video i~
Authors:  Kansal Tags: Add atag
~ Hide Folders Tools v [ swe | | Cancel

1il.

1v.

V.

Fig 6.9: Save As dialog box — Saving presentation in Video Format

Select a location and type the name for the file.

Select the ““Save as type’” drop down arrow and choose Windows Media Video (*wmv)

Click on Save button to create Video file.

As the conversion to .wmv format begins, there will be a progress bar displayed in the

lower right corner of PowerPoint that indicates the pace. The time taken for the conversion will

depend on the size of the PowerPoint file.

Once the presentation is converted to video, the video can be posted to a website, Facebook

or YouTube for others to view or it can be played on computers using any video player.

6.5.3 Save a Presentation as a PowerPoint Show

We can save our PowerPoint presentation as a PowerPoint Show (a .ppsx file) so that it

automatically starts the slide show when the file is opened. Following are the steps to save a

presentation as PowerPoint show:

1.

ii.

iil.

1v.

V.
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Click on File tab

Click on Save As option

Select a location and type the name for the file.

Select the ““Save as type” drop down arrow and choose PowerPoint Show

Click on Save button to create PowerPoint Show.
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[P] saveAs X
1+ <« Users » Kansal » Documents » v O Search Documents P
Organize = Mew folder f= - 0
-~
3 This PC A Name Date modified Type
:i 3D Objects j Files for Movie Maker 03-06-2020 10:58 File folder
B Desktop My Data Sources 06-06-2020 11:13 File folder
Documents j Sound recordings 21-08-2020 10:32 File folder
j Visual Studio 2015 09-09-2020 15:51 File folder
; Downloads T . .
__l Wondershare Filmora 18-05-2020 14:47 File folder
b Music
[=] Pictures
B Videos
He Winl0 (C) v < >
( File name: | Computer Systern v
Save as type: | PowerPoint Show V)
Authors: Kansal Tags: Add atag
~ Hide Folders Tools  ~ I Save ] | Cancel ]

Fig 6.10: Save As dialog box — Saving presentation as PowerPoint Show

The file is saved as a .ppsx file. When the file is double-clicked, it directly opens as a slide show.

6.5.4 Save Presentation in the form of Picture Files
We can either save all slides as images at the same time or do one slide at a time. Following
steps shows how to save presentation slides as pictures:

1.

1l.

Click on File tab
Click on Save As option

[P] Save As
T

Organize v Nej

i Win10 (C3)

File name:

PowerPoint Presentation

PowerPoint Macro-Enabled Presentation
PowerPoint 97-2003 Presentation

PDF

XPS Document

PowerPoint Template

PowerPoint Macro-Enabled Template
PowerPoint 97-2003 Template

Office Theme

PowerPoint Show

hanced Windows Metafile

E This PC PowerPoint Macro-Enabled Show
:‘ 3D Objects PowerPoint 97-2003 Show
PowerPoint Add-In
[ Desktop  |PowerPoint 97-2003 Add-In
g PowerPoint XML Presentation
Documents \\yindows Media Video
3 Downloads i iGrai hics Interchanie Format i
. JPEG File Interchange Format
P Music PNG Portable Network Graphics Format
[&) Pictures TIFF Tag Image File Format
Device Independent Bitmap
B videos Windows Metafile

/)

Outline/RTF
PowerPoint Picture Presentation
OpenDocument Presentation

Save as type:

PowerPoint Show

Authors:  Kansal

A Hide Folders

Tags: Add atag

Tools = I

Save

| |

Cancel

Fig 6.11: Save As dialog box — Saving presentation in picture Format
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iii.

1v.

Vi.

Vi.

Select a location and type the name for the file.

Select the “‘Save as type” drop down arrow and choose one of the following image
formats to save the slide in the form of pictures

. GIF Graphics Interchange Format

° JPEG File Interchange Format

. PNG Portable Network Graphics Format
° TIFF Tag Image File Format

° BMP Device Independent Bitmap

. WMF Windows MetaFile

° EMF Enhanced Windows MetaFile
Click on Save button.

A new dialog shows up asking with 3 buttons: “Every Slide”, “Current Slide Only” or
“Cancel”. Select the appropriate option as per the requirement.

Microsoft PowerPoint X

o Do you want to export every slide in the presentation or only the current slide?

I Every Slide I | Current Slide Only | l Cancel |

A confirmation message shows up telling us that all our slides or current slide have
been saved as a separate image. Click “OK”.

This is a really neat feature if we want to post an image of a slide or a whole Slide Show on

our blog or online.

Points To Remember:

1.
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A slide transition is the visual and motion effect that occurs when we move from one
slide to the next slide during a presentation.

Animations are visual effects that display movement on the objects in the presentation.

PowerPoint provides four types of animations: Entrance, Emphasis, Exit and Motion
Paths.

PowerPoint provides predefined collection of animation effects which are also known
as Animation Schemes.

The Animation pane allows us to view and manage all of the effects that are on the
current slide.

Animation Painter option is used to copy animation effect.
Preview button in Preview group of Animations tab can be used at any time to test

how our animations look.
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8. Record Slide Show feature is similar to the Rehearse Timing feature

9. The biggest advantage of saving a presentation in PDF is that recipients won't be able
to edit our presentation contents.

10. We can save our PowerPoint presentation as a PowerPoint Show (a .ppsx file) so that
it automatically starts the slide show when the file is opened.

Y
| | EXERCISE )

1.  Multiple Choice Questions:

. A is the visual and motion effect that occurs when we move from one

slide to the next slide during a presentation

a)  Slide transition b)  Animation
¢) Animation Scheme d)  Slide Show
II. PowerPoint provides types of animations
a) Two b)  Three
c¢) Four d) Five
III. PowerPoint provides predefined collection of animation effects which are also known
as
a)  Slide transition b)  Animation
¢) Animation Scheme d)  Slide Show
IV. Full Form of PDF is
a)  Portable Data Format b)  Portable Document Form
c¢) Portable Data Form d) Portable Document Format
V. We can save our PowerPoint presentation as a PowerPoint Show with
extension.
a)  .ppsx b) .ppt
c) .pptx d) .pdf
2.  Fillin the Blanks:
I.  Using tab, we can apply transition effects.
II. option allows us to increase or decrease the duration or time of the effect.
1. option is used to copy animation effect.
IV. To save a presentation file in other formats, we have to use option.

3.  Short Answer Type Questions
I.  Whatis Slide Transition?
II.  Whatis Animation?
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A

III. What are Animation Schemes in PowerPoint?

IV. How will you preview animations in PowerPoint?

V.  Write the name of four types of animations available in PowerPoint.

Long Answer Type Questions

I.  What is Animation? What are its types in PowerPoint?

II. How will you save PowerPoint presentation in PDF format?

III. How will you apply Slide Transition in PowerPoint?

[CabrActivity:

ACTIVITY -1
Create a New blank presentation having at least 5 slides.
First slide : Write about Internet
Second Slide : Hardware Requirements of Internet
Third Slide : Software Requirements of Internet
Fourth Slide : Types of Internet Connection
Fifth Slide : Write about your name and school name
Format the Background of all slides with the Solid Color
Apply Slide Transition Effects on all Slides
Save it with your Roll No and Section
Run the Slide Show to present it to other students of your class
Save the presentation as PDF

ACTIVITY -11
Create a New blank presentation having at least 5 slides.
First slide : Write about Information Technology
Second Slide : What is Web Site?
Third Slide : What is Web Surfing?
Fourth Slide : What is Downloading?
Fifth Slide : Write about your name and school name

Format the Background of all slides with Gradient Fill

Apply Slide Transition and Animation Effects on all Slides and its objects

Save it with your Roll No and Section
Run the Slide Show to present it to other students of your class

Save the presentation as a video

70

COMPUTER SCIENCE



»

‘D
L ] )
» 4

GENERATIONS OF

| CHAPTER - 7 | COMPUTER

( OBJECTIVES OF THIS CHAPTER )

-

7.1 Introduction

~

7.2 First Generation Computers
7.3 Second Generation Computers
7.4  Third Generation Computers

7.5  Fourth Generation Computers

7.6 Fifth Generation Computers
- J

7.1 INTRODUCTION

In computer terminology, Generation is a change in technology of computer. Earlier, the

generation term was used to distinguish between varying hardware technologies. But now-a-
days, generation includes both hardware and software, which together make up an entire computer
system. There are totally five computer generations known till date. These are explained as
follows:

7.2 FIRST GENERATION COMPUTERS (1942-1955)

The time period of first generation was 1942-1955. The first
generation computers used vacuum tubes as the basic components for
memory and circuitry for CPU (Central Processing Unit). These tubes
were like electric bulbs which produced a lot of heat and were prone to
frequent fusing. They were very expensive and could be afforded only
by very large organizations.

In this generation, mainly Batch Processing Operating Systems

were used. Punched cards, Paper tape and Magnetic tapes were used as
Input & Output devices. Machine codes and electric wired board  Figure 7.1 Vacuum Tube
languages used to operate the machines.

Main features and characteristics of First Generation:

*  Vacuum Tubes as basic processing component, Electromagnetic Relay as main
memory; Punched Cards as secondary storage were used.
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*  Machine and Assembly languages and stored program concept for operating the
machines were used.

*  They were very much bulky in size and produce a lot of heat.
*  They were not much reliable systems.

*  They could not be commercially used.

*  They were costly and difficult to use.

Examples of First Generation Computer Systems:

*  ENIAC (Electronic Numerical Integrator and Computer)

*  EDVAC (Electronic Discrete Variable Automatic Computer)
* EDSAC (Electronic Delay Storage Automatic Calculator)

*  UNIVAC I (Universal Automatic Computer I)

* IBM 701 (International Business Machines 701)

7.3 SECOND GENERATION COMPUTERS (1955-1964):

The time period of second generation was 1955-1964. This generation used the transistor
as their basic processing component. They were cheaper, consumed less power, more compact
in size, more reliable and faster than the first generation machines. In this generation, magnetic
cores were used as primary memory, and magnetic tape and magnetic disks as secondary storage

M

devices.

Figure 7.2 Transistor

In this generation, Assembly Language and High-Level Programming languages like
FORTRAN and COBOL were used. Batch processing and Multiprogramming Operating systems
were also used.

Main features and characteristics of Second Generation:

* Transistors as the basic processing components, magnetic cores as main memory,
Magnetic Tapes and Disks as secondary storage were used.

*  Batch Operating System and High-Level Programming Languages were used.

* They were faster, smaller in size, more reliable and easier to program than first
generation systems and were used for scientific and commercial applications.

*  Commercial production of second generation computers was still difficult.

*  They were costly.
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*  They generated less heat as compared to first generation computers.

*  They consumed less electricity as compared to first generation computers.
Examples of Second-GenerationComputer Systems:

* IBM 7030

*  UNIVAC LARC (Livermore Advanced Research Computer).

7.4 THIRD GENERATION COMPUTERS (1964-1975)

The time period of third generation was 1964-1975. The third generation of computer used
Integrated Circuits (IC's) in place of transistors. A single IC has many transistors, resistors and
capacitors along with the associated circuitry. The IC was invented by Jack Kilby. This
development made computers smaller in size, reliable and efficient.

Figure: 7.3 IC (Integrated Circuit)

In this generation, Remote processing, Time-sharing, Real-time, Multi-programming
Operating Systems were used. High-level languages such as FORTRAN-II TO 1V, COBOL,
PASCAL PL/1, BASIC, ALGOL-68, etc. were used during this generation.

Main features and characteristics of Third Generation:
* [Cs with SSI and MSI technologies were used as basic processing components

*  Larger magnetic cores main memory, larger capacity disks and magnetic tapes as
secondary storage were used.

*  Theyused Time sharing operating system and multi-programming operating systems.

*  They were commercially easier to use and easier to upgrade.

*  They were used for Scientific, commercial and interactive online applications.
Examples of Third Generation Computer Systems:

* IBM 360/370-(International Business Machines 360/370)

*  PDP-8-(Personal Data Processor-8)

*  PDP-11-(Personal Data Processor-11)

*  (CDC 6600-(Control Data Corporation 6600)
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7.5 FOURTH GENERATION COMPUTERS (1975-1989)

The period of Fourth Generation was 1975-1989. The fourth generation of computers used
Very Large Scale Integrated (VLSI) circuits. VLSI circuits having about 5000 transistors, other
circuit elements and their associated circuits, all on a single chip made it possible to have

microcomputers of fourth generation. Fourth Generation computers became more powerful,
compact, reliable, and affordable. As a result, it gave rise to personal computer (PC) revolution.

Figure: 7.4 Microprocessors

In this generation, Time sharing, Real time, Network, Distributed Operating Systems were
used. All the higher level languages like C and C++, DBASE, etc., were used in this generation.

Main features and characteristics of Fourth Generation:

ICs with VLSI Technology and microprocessors as processing components were used
in the computers of this generation.

Semiconductor main memories and larger capacity hard disks as secondary storage
were used in these computers.

Magnetic tapes and floppy disks were used as portable storage media.

Operating systems for PCs with GUI and multiple windows on a single terminal screen
were used in these computers.

Multi-Processing OS, UNIX Operating System, C Programming language, Object-
Oriented Programming were used in these computers.

PC, Network-based and supercomputing applications were used in these computers.
These computers were small, affordable, reliable, and easy to use.

They were totally general purpose machines, easier to produce commercially and easier
to upgrade.

Examples of Fourth Generation Computer Systems:

74

IBM PC and its clones
Apple 11

CRAY-1

CRAY-2

CRAY-X/MP
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7.6 FIFTH GENERATION COMPUTERS (1989-onwards):

The period of Fifth Generation is 1989-till date. In the fifth generation, the VLSI technology
became ULSI (Ultra Large Scale Integration) technology. The ULSI microprocessor chips have
ten million electronic components in them.

Figure:7.5 ULSI chip

This generation is based on Parallel Processing Hardware and Al (Artificial Intelligence)
software. Al is an upcoming branch in computer science which interprets means and methods of
making computers think like human beings.

Al includes the following areas:
*  Robotics
*  Game Playing
*  Development of Expert Systems to make decisions in real life situations
*  Natural language understanding and speaking

All the higher level languages like C, C++, Java, .Net, etc., are used in this generation.

-

%

Fig 7.6 Robotics using AI (Artificial Intelligence)

Main features and characteristics of Fifth Generation:

*  ICs with ULSI technology, larger capacity main memory, hard disks with RAID support
are used.

®  Optical disks as portable read-only storage media are used.
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Notebooks, powerful desktop PCs and workstations, powerful servers and
supercomputers are used in this generation.

Internet and Cluster computing is used.

Multithreading, Distributed OS, Parallel Programming,JAVA, World Wide Web,
Multimedia, Internet based applications are used.

These are portable computers, and are more powerful, cheaper, reliable, and easier to
use.

These computers have high uptime due to hot-pluggable components and they are
totally general purpose machines.

These computers are easier to produce commercially.

Rapid software development is possible

Examples of Fifth Generation Computer Systems:

IBM notebooks
Pentium PCs

SUN Workstations
IBM SP/2
PARAM 10000

Points To Remember:

1.
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In computer terminology, Generation is a change in hardware as well as software
technology of computer.

The first generation computers used Vacuum Tubes as the basic components for memory
and circuitry for CPU

Second generation used the Transistor as their basic component.
The third generation of computer used Integrated Circuits (IC's) in place of transistors.

A single IC has many transistors, resistors and capacitors along with the associated
circuitry.

The fourth generation of computers used Very Large Scale Integrated (VLSI) circuits.

Fourth Generation computers became more powerful, compact, reliable, and affordable.
As aresult, it gave rise to personal computer (PC) revolution.

In the fifth generation, the VLSI technology became ULSI (Ultra Large Scale
Integration) technology.

Al is an upcoming branch in computer science which interprets means and methods
of making computers think like human beings.
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@ﬁj EXERCISE )

1.  Multiple Choice Questions:

I.  Second generation of computers used the

a)  Vacuum Tubes b)

c) ULSI d)
II. The

a)  First b)

c¢) Third d)
III. The third generation of computers used

a) Integrated Circuits b)

c¢) ULSI d)

as their basic component.

VLSI

Transistor

generation of computers used VLSI circuits.

Second
Fourth
in place of transistors.
Vacuum Tubes
VLSI

IV. is an upcoming branch in computer science which interprets means and
methods of making computers think like human beings.
a)  Robotics c¢) ULSI
c) Arttificial Intelligence d) Integrated Circuits

V. ULSI technology is used in generation of computers.
a)  Second b)  Third
c¢) Fourth d) Fifth

2.  Write the Full forms:

I.  ENIAC II. IBM

1. 1C IV. VLSI

V. ULSI VI. Ol

3.  Very Short Answer Type Questions

I.  Write the main features of First Generation computers.

II.  Which technology was used for Second Generation of Computers?

III. What is IC?

IV. Write about Fourth Generation of computers.

V. What is AI? Write the areas which are included in Al

VI.
4. Long Answer Type Questions

Write the examples of First Generation of Computers.

I.  What do you mean by Generation of Computers? How are they classified?

II.  Explain Fifth Generation of Computers.
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CHAPTER - 8 COMPUTER MEMORIES

( OBJECTIVES OF THIS CHAPTER )

4 )
8.1  What is Memory?
8.1.1  Memory Units
8.2  Types of Memory
8.2.1 Internal Memory
8.2.2  External Memory
8.3 Physical Structure of Magnetic disks
8.3.1  Tracks
8.3.2  Sectors
- J

8.1 WHAT IS MEMORY ?

Computer Memory is just like a human brain. It is the storage space of computer where a

computer can store all the required data and instructions for processing that data. Computer

memory is divided into a large number of small parts, called cells. Each location or cell has a
unique memory address.

8.1.1 Memory Units

Memory capacity of a computer is the amount of data that can be stored in the memory
device which is equal to the number of bytes that can be stored in its storage device. The storage

capacity is expressed in terms of Bytes. Following are the main memory storage units:

78

Bit (Binary Digit) : A bit or a binary digit may be represented by logical 0 and 1.
Nibble : A group of 4 bits is called nibble, e.g. (1011)

Byte : A group of 8 bits is called byte. A byte is the smallest unit which can represent
a data item or a character e.g. (01000001)

Word : A computer word is a group of fixed number of bit which is processed as a
unit. The length of a computer word is called word-size or word-length. It may be as
small as 8 bits or may be as long as 96 bits. A computer stores the information in the
form of computer words.
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Measuring Units for Computer Memory:

Sr. No. Memory Unit Description
1 Bit Single Binary digit either 0 or 1
2 Nibble Group of 4 bits
3 Byte Group of 8 bits
4 Kilobyte (KB) 1 KB = 1024 Bytes
5 Megabyte (MB) 1 MB =1024 KB
6 Gigabyte (GB) 1 GB =1024 MB
7 Terabyte (TB) 1 TB=1024 GB
8 Petabyte (PB) 1 PB=1024 TB

Fig: 8.1 Measuring Units for Computer Memory

8.2 TYPES OF MEMORY:

Following Figure shows the basic classification of Memories:

A
4 [CPU Registers J
Internal
Cache Memory Memory
Speed [ Main Memory ]
Increases v

As we move up

[ Magnetic Disk J I

[ Optical Disk ] External

Memory

[ Magnetic Tape J
v

Fig: 8.2 Types of Memory
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Memory can be classified into two main categories: Internal & External

8.2.1 Internal Memory

The instructions of a program and related data are placed in such a memory where CPU
can work on them. The CPU uses Internal Memory for such purposes. CPU Registers, Cache
Memory and Main Memory comes under the category of Internal Memory. These different types
of memories are explained below:

8.2.1.1 CPU Registers : A register is a fastest and temporary memory built into CPU.
These registers are used to store/transfer data and instructions which are being used immediately
by the CPU. The registers used by the CPU are often termed as Processor registers. A processor
register may hold an instruction, a storage address, or any data. Common examples of CPU
registers are: Instruction Register (IR), Memory Buffer Register (MBR), Memory Data Register
CPU Cache Memory Main Memory (RAM)

(MDR), and Memory Address Register (MAR).
Frequently used O
“ data and I“
Instructions Secondary
“ Memory
(Disk)
Registers | | 4

Fig 8.3: Relationship between Different types of memories

N~

8.2.1.2 Cache Memory : Cache memory is a very high speed semiconductor memory
which can speed up the working of CPU. It acts as a buffer between the CPU and Main Memory
(RAM). It is used to holddata and instructions of a program which are frequently used by CPU.

Advantages of cache memory :
*  Cache memory is faster than main memory.
* It takes less access time as compared to main memory.
* [t stores the program that can be executed within a short period of time.
* [t stores data for temporary use.
Disadvantages of cache memory:
*  Cache memory has limited capacity.
* Itis very expensive.

8.2.1.3 Primary/Main memory : Primary memory is directly accessible by CPU. A
computer cannot run without primary memory. These memories are located close to the CPU on
the computer motherboard. CPU can read data from primary memory very quickly. It is used to
store data that the CPU needs immediately. These memories are faster than secondary memories

but slower than registers and cache memories. Primary memory can be classified into two main
categories RAM and ROM:
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( Primary Memory J

e | | GETe
| | | |

SRAM DRAM MROM EPROM

PROM EEPROM
Fig 8.4: Types of Primary Memory

(i) RAM (Random Access Memory) : RAM stands for Random Access Memory. It stores the
programs and data that our computer system is actively using so that it can be accessed quickly.
It is a read/write memory which means we can read from and write into this memory. But, we
cannot store data permanently into this memory. It is a volatile memory which means data stored
in it is lost when we switch off the computer or if there is a power failure. This is the reason a
backup Uninterruptible Power Supply (UPS) is often used with computers. Data in the RAM
can be accessed randomly but it is very expensive memory. RAM is small, both in terms of its
physical size and in the amount of data it can hold. RAM can further be classified into following
two types:

Fig 8.5: RAM

(a) Static RAM (SRAM) : The word static indicates that the memory retains its contents as long
as power is being supplied. However, data is lost when the power gets down due to volatile
nature. SRAM chips use a matrix of 6-transistors and no capacitors. Transistors do not require
power to prevent leakage, so SRAM need not have to be refreshed on a regular basis.

Characteristic of the Static RAM:
* [t has long life
®  There is no need to refresh
*  Faster

* Used as cache memory
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* Large size

*  Expensive

*  High power consumption
(b) Dynamic RAM (DRAM) : DRAM must be refreshed in order to maintain the data. This is
done by placing the memory on a refresh circuit that rewrites the data several hundred times per
second. All DRAMs are made up of memory cells which are composed of one capacitor and one
transistor. DRAM is used for system memory because it is cheap and small.
Characteristics of the Dynamic RAM:

* It has short lifetime

* Need to be refreshed continuously

*  Slower as compared to SRAM

* Used as RAM

*  Lesser in size

* Lessexpensive

*  Less power consumption
(ii) ROM (Read Only Memory) : ROM stands for Read Only Memory. This is the memory
from where we can only read, but cannot write on it. This type of memory is non-volatile that
means the information is stored permanently in such memories during the time of manufacturing.
A ROM, stores such instructions that are required to start a computer. This operation is referred

to as bootstrap. ROM chips are not only used in the computer but also in other electronic items
like washing machine and microwave oven etc.

Fig 8.6: ROM

Following are the various types of ROM:

(a) MROM (Masked ROM) : Earlier ROMs were hard-wired devices that contained a
pre-programmed set of data or instructions. These kinds of ROMs are known as masked
ROMs which are inexpensive.

(b) PROM (Programmable Read only Memory) : PROM is read-only memory that
can be modified only once. We can buy a blank PROM and enters the desired contents
using a PROM program. It can be programmed only once and is not erasable.
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(d)

EPROM (Erasable and Programmable Read Only Memory) : The EPROM can
be erased by exposing it to ultra-violet rays/lights. During programming, an electrical
charge is used. This charge can be retained for more than ten years. For erasing this
charge, ultra-violet rays are passed through it.

EEPROM (Electrically Erasable and Programmable Read Only Memory) : The
EEPROM is programmed and erased electrically. It can be erased and reprogrammed
about ten thousand times. In EEPROM, any location can be selectively erased and
programmed. EEPROMSs can be erased one byte at a time, rather than erasing the
entire chip. Hence, the process of re-programming is flexible but slow.

Advantages of ROM :

Non-volatile in nature.

These cannot be accidentally changed.
Cheaper than RAMs.

More reliable than RAMs

These are static and do not require refreshing.

8.2.2 External Memory

This type of memory is also known as secondary or auxiliary or non-volatile memory. It is
slower than main memory. These are used for storing data and Information permanently. CPU
does not access these memories directly. They are accessed via input-output routines. Contents
of secondary memories are first transferred to main memory, and then CPU can access it. For
example: Hard disk, CD-ROM, DVD etc.

A

Fig 8.7: External Memory (HDD)

Characteristic of Secondary Memory:

These are magnetic and optical memories.

Backup / Reusable memory : Data stays in the secondary storage on permanent
basis until it is not overwritten or deleted by the user.

Non-volatile memory : Data is permanently stored even if power is switched off.

Reliable : Data in secondary storage is safe because of high physical stability of
secondary storage device.
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*  Convenience : With the help of computer software, authorized people can locate and
access the data quickly.

*  Capacity : Secondary storage can store large volumes of data in sets of multiple
disks.

*  Cost: Itis much lesser expensive to store data on a tape or disk than primary memory.
*  Computer may start without secondary memory.
*  Slower than primary memories.

External/Secondary Memory is mainly of two types. Following diagram shows different types
of secondary memory:

Secondary Storage
Devices
I I
Sequential Access Direct Access Devices
Device
I
Magnetic Tape
! |
Magnetic Optical Disks Memory Storage
Disks Devices
,_I_‘ I |
Floppy Hard CD-ROM WORM CD-Rw Dvp Flash — Memory
Disk Disks (CD-R) Drive Card

Fig: 8.8 Types of External/Secondary Memory devices

8.2.2.1 Sequential Access Devices : In these types of storage devices, data can only be retrieved
in sequential order, in which it is stored. These devices are suitable for sequential processing
applications where most of the data records need to be processed one after another.

Sequential Access

NSNS

A~ A 7 N eee

1 2 3 4 5 6 7

Fig: 8.9 Concept of Sequential Access

Magnetic tape is a good example of such types of storage device. Storage Capacity of magnetic
tape depends upon the length of the tape. Data storage capacity is the amount of data that can be
stored on a given length of tape. It is measured in bytes per inch (bpi)

Storage capacity of a tape = Data recording density x Length
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8.2.2.2 Direct Access Devices : In these storage devices, any storage location may be selected
and accessed randomly. They permit access to individual information in a more direct or immediate

manner.
Direct Access

/N
1 3 7 2 6 4 5

Fig: 8.10 Concept of Direct Access

These storage devices are suitable for direct processing applications such as online ticket
booking systems, on-line banking systems etc. Magnetic, optical, and magneto-optical disks are
examples of direct access storage devices.

8.3 PHYSICAL STRUCTURE OF MAGNETIC DISK

Magnetic disk is a secondary storage device which is used to store data permanently. We
can access stored data in the sequential as well as random manner from the magnetic disk. A
magnetic disk is divided into tracks and sectors. Following figures shows the physical structure
of magnetic disk:

8.3.1 Tracks

The surface of disk is divided into a number of invisible concentric circles, called tracks.
These tracks are numbered consecutively from outermost to innermost starting from zero. The
number of tracks on a disk may vary according to the capacity of disks.

1 sector = 512 bytes a track
e —

Fig: 8.11 Tracks and Sectors on a Magnetic Disk
8.3.2 Sectors

Each track of a disk is subdivided into small portions, known as sectors. There are 8 or more
sectors per track. A sector typically contains 512 bytes.

Storage capacity of a disk system may be calculated by using the following formula:
Storage Capacity = Number of recording surfaces x Number of tracks per surface x

Number of sectors per track x Number of bytes per sector
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Points To Remember:

1. Memory is the storage space of computer where a computer can store all the required
data and instructions for processing that data.

2.  Memory capacity of a computer is the amount of data that can be stored in the memory
device.

3. Cache memory is a very high speed semiconductor memory which can speed up the
working of CPU.

A computer cannot run without primary memory.
RAM stands for Random Access Memory.
ROM stands for Read Only Memory.

The surface of disk is divided into a number of invisible concentric circles, called

NS e

tracks.

Each track of a disk is sub divided into small portions, known as sectors.

© o

External Memory is also known as secondary or auxiliary or non-volatile memory.

2
| | EXERCISE )

1.  Multiple Choice Questions:

I. A groupof bits is called byte
a) 8 b) 16
c) 32 d o4

II. A bit or a binary digit may be represented by logical and
a) 0,1 b) 0,0
¢ 1,2 d 1,1

III. RAM stands for
a) Read Access Memory b) Random Access Memory
c) Allofthese d)  None of these

IV. ROM stands for
a) Read Only Memory b) Random Only Memory
¢) Read Open Memory d)  None of these

V. Each track of a disk is sub divided into small portions known as
a)  Sector b) Area
c) Cell d) Tape

2.  Write Full forms of the following terms:

. MB 1. GB

1. RAM IV. ROM

V. IR
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3.  Short Answer Type Questions
I.  Whatis Memory?
II.  Write the namesof different types of Memories
III. What is Primary Memory?
IV. Write the name of various types of ROM.
4. Long Answer Type Questions
I.  Explain RAM and ROM.
II.  Explain the External Memory.
III. Explain the Characteristic of Secondary Memory.
IV. What are Tracks and Sectors?
V. What is Cache Memory? What are its advantages and disadvantages?

[CabrActivitby,

Fill the blanks in following figure about basic classification of Memories.

Internal
Memory
Speed

Increases v
As we move up
[ ] “

External

Memory

<
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APPENDIX -1

Lab Activity for Typing Practice in English

EXERCISE I
asdfg  ;lkjh asdfg ;Ikjh asdfg ;1kjh asdfg ;Ikjh asdfg
asdfg  ;lkjh asdfg ;Ikjh asdfg ;1kjh asdfg ;Ikjh asdfg
asdfg  ;lkjh asdfg ;Ikjh asdfg ;Ikjh asdfg ;1kjh asdfg
asdfg  ;lkjh asdfg ;Ikjh asdfg ;1kjh asdfg ;1kjh asdfg
asdfg  ;lkjh asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg
EXERCISE II

Ask Fad Alsas Shad Lads Flags Flask

Jag Fag Fall Hash Glad Galls Salad

Jak Had Gaff Dash Gall Flash Slash

Sad Lad Adds Lash Hall Lakhs Dhalls

Dad Asks Alas Dall Fall Glass Shall

EXERCISE III
qwert  poiuy qgwert  poiuy qwert poiuy  qwert poiuy  qwert
poiuy qwert poiuy qwert poiuy qwert poiuy gqwert  poiuy
qwert  poiuy qgwert  poiuy qwert poiuy  qwert poiuy  qwert
poiuy qwert poiuy qwert poiuy qwert poiuy gwert  poiuy
gwert poiuy qwert poiuy qwert poiuy  qwert poiuy  qwert
poiuy qwert poiuy qwert poiuy qwert poiuy qwert  poiuy
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EXERCISE IV

awerqfa ;01upj; awerqfa ;01upj; awerqfa ;01upj;
awerqfa ;01upj; awerqfa ;01upj; awerqfa ;01upj;
awerqfa ;o1upj; awerqfa ;o1upj; awerqfa ;01upj;
awerqfa ;o1upj; awerqfa ;o1upj; awerqfa ;01upj;
awerqfa ;o1upj; awerqfa ;o1upj; awerqfa ;01upj;
EXERCISE V
Fish Dirks Oldest Apple Grade Falls Kodak
Rails Jaded Dead Usual Sales Filed Legal
Lease Lakes Agile Isles Ahead Larks Roses
Forks Hedge Skill Rupee Grass Would Alpine
Jaded Liked Equip Quail Jokes Asked Walks
Fiddle  Saddle Dead Filed Lakes Lease Legal
EXERCISE VI
azxevf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxevf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxevf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxevf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxevf lkmnbj azxcvf lkmnbj azxcvf lkmnb;j
EXERCISE VII
Cat Jack Colour Neither Enemy Boat Calcutta
Not Have Joints Calling Voted Very Vineyard
Met Wind  Nerves Enlarge Money Move Material
Men Verb Verbal Someone Marry Give Sterling
Bent Joint Jackets Examine Thousand Cylinder Assessment
King  Carry Jumbled Examined  Struggle Possible Beginning
Zeal Night  Booklet  Gracious Grizzled Frequent Meanings
Zero Tonic  Cutting Becoming  Zodiacal Exponent  Doubtless
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EXERCISE VIII

12345
12345
12345
12345
12345

098767
098767
098767
098767
098767

12345
12345
12345
12345
12345

098767
098767
098767
098767
098767

12345
12345
12345
12345
12345

098767
098767
098767
098767
098767

EXERCISE IX

Type the following sentences 5 times:

2 LR e H;s =

—_ =
—_ O

Lost time is never regained.

Get-up early and do your work.

Today's youth and tomorrow's old

Age is a virtue when wisdom is with it.

Measure your word before it goes out of you.

My steps are measured.

A friend in need is a friend indeed.

Children are innocent and should be guided rightly.
Our Land has great sages who knew the eternal truth.
Truth never fails.

The Quick Brown Fox Jumps Over A Lazy Dog.

EXERCISE X

Type the following paragraph 10 times:

Our flag is tri-colour. SAFFRON is the symbol of sacrifice and a string mind. WHITE is
the symbol of purity, love and peace. GREEN is the symbol of plenty and joy. We hoist

and salute our flag. We are ready to make sacrifices for our country. We want peace and

progress. We want to be pure.
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APPENDIX - II

COMMONLY USED FULL FORMS

ACRONYM FULL FORM

Al ARTIFICIAL INTELLIGENCE

ARPANET ADVANCED RESEARCH PROJECT AGENCY NETWORK

BMP BITMAP PICTURE

bpi BITS PER INCH

CD COMPACT DISK

CPU CENTRAL PROCESSING UNIT

CSS CASCADING STYLE SHEET

CUI CHARACTER USER INTERFACE

DOS DISK OPERATING SYSTEM

DRAM DYNAMIC RANDOM ACCESS MEMORY

DSL DIGITAL SUBSCRIBER LINE

DVD DIGITAL VIDEO DISK

E COMMERCE ELECTRONIC COMMERCE

EEPROM ELECTRONICALLY ERASABLE PROGRAMMABLE READ
ONLY MEMROY

EMAIL ELECTRONIC MAIL

EPROM ERASABLE PROGRAMMABLE READ ONLY MEMROY

FTP FILE TRANSFER PROTOCOL

GB GIGABYTE

GIF GRAPHICS INTERCHANGE FORMAT

GUI GRAPHICAL USER INTERFACE

HTML HYPER TEXT MARKUP LANGUAGE

IAP INTERNET ACCESS PROVIDER

IBM INTERNATIONAL BUSINESS MACHINE

IC INTEGRATED CIRCUIT

ISDN

INTEGRATED SERVICE DIGITAL NETWORK
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ISP

INTERNET SERVICE PROVIDER

IT

INFORMATION TECHNOLOGY

JPEG JOINT PHOTOGRAPHIC EXPERTS GROUP
KB KILOBYTE

MB MEGABYTE

MIDI MUSICAL INSTRUMENT DIGITAL IDENTIFIER
MODEM MODULATER DEMODULATER

MPEG MOVING PICTURE EXPERTS GROUP

MROM MASKED READ ONLY MEMORY

NIC NETWORK INTERFACE CARD

PB PETA BYTE

PC PERSONAL COMPUTER

PNG PORTABLE NETWORK GRAPHICS

POP POST OFFICE PROTOCOL

PROM PROGRAMMABLE READ ONLY MEMORY
RAM RANDOM ACCESS MEMORY

ROM READ ONLY MEMORY

RTF RICH TEXT FORMAT

SERP SEARCH ENGINE RESULT PAGE

SMTP SIMPLE MAIL TRANSFER PROTOCOL

SRAM STATIC RANDOM ACCESS MEMORY

TB TERABYTE

TCP/IP TRANSMITION CONTROL PROTOCOL

ULSI ULTRA LARGE SCALE INTEGRATED CIRCUIT
UPS UNINTERRUPTIBLE POWER SUPPLY

URL UNIFORM RESOURCE LOCATER

USB UNIVERSAL SERIAL BUS

VLSI VERY LARGE SCALE INTEGRATED CIRCUIT

Www

WORLD WIDE WEB
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APPENDIX - III

COMMONLY USED SHORTCUT KEYS

(MS WORD)
Shortcut Keys Used for
Ctrl+A Select All
Ctrl+B Bold the selected text
Ctrl+C Copy the selected contents
Ctrl+D Opens the Font Dialog Box
Ctrl+E Center Align text
Ctrl+F Find text
Ctrl+G Goto line/page no etc.
Ctrl+H Replace text
Ctrl+1 Italic the selected text
Ctrl+J Justify paragraph
Ctrl+K Create Hyperlink for the selected text
Ctrl+L Left Align the paragraph
Ctrl+M Increase Indent
Ctrl+N Create a New File
Ctrl+O Open Existing File
Ctrl+P Print File
Ctrl+Q Clear Indents and Tabs
Ctrl+R Right Align the text
Ctrl+S Save File
Ctrl+T Increase Hanging Indent
Ctrl+U Underline the selected contents
Ctrl+V Paste the contents from the clipboard
Ctrl+W Close File
Ctrl+X Cut the selected contents
Ctrl+Y Redo the last action (if possible)
Ctrl+Z Undo the last operation
Ctrl+1 Single Line Spacing
Ctrl+2 Double Line Spacing
Ctrl+5 1.5 Line Spacing
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Ctrl+]

Increase Font Size

Ctrl+[ Decrease Font Size

Ctrl+Shift+C Copy the Formats of selected text
Ctrl+Shift+V Paste the copied Formats on selected text
Shift+F3 Change Case

F7 Spelling and Grammar Check

Alt+F4 Close Program
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COMMONLY USED SHORTCUT KEYS
(MS POWERPOINT)

Shortcut Key Used for

Alt + A Go to the Animations tab

Alt+F Open the File tab menu

Alt+ F2 or F12 Open the Save As dialog box

Alt+G Open the Design tab

Alt+H Go to the Home tab

Alt + K Go to the Transitions tab

Alt +N Open the Insert tab

Alt+Q Directs to the “Tell me what you want to do” box

Alt+R Go to the Review tab

Alt+ S Go to the Slide Show tab

Alt+W Go to View tab

Alt+X Go to the Add-ins tab

Alt+Y Go to the Help tab

Alt or F10 Turn the key tips to ‘on’ or ‘off”

Ctrl + A Select all the objects on an active slide

Ctrl + Alt +V Open the Paste Special dialog box

Ctrl + B Toggle bold on the selected text

Ctrl + C Copy the selected text, object, or selected slide

Ctrl + D Duplicate the selected object or a slide

Ctrl + E Center align the selected text

Ctrl + F Search in a presentation or use Find and Replace

Ctrl + F1 Show or hide the ribbon

Ctrl + F2 Print Preview View

Ctrl + 1 Toggle italics on the selected text

Ctrl +1J Justify the selected text

Ctrl + K Insert a hyperlink

Ctrl + L Left align the selected text

Ctrl + M Insert a new slide

Ctrl + N Create a new presentation document

Ctrl + O Open an existing presentation document
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Ctrl + P

Annotate using a Pen tool while playing the slideshow

Ctrl + Q Save and close a presentation

Ctrl + R Right align the selected text

Ctrl + S Save a presentation

Ctrl+ T Display the Font dialog box after text or object is selected
Ctrl + U Add or remove underline to selected text

Ctrl +V Paste the selected text, object, or slide

Ctrl + W or Ctrl + F4

Close a presentation

Ctrl + X Cut the selected text, object, or slide
Ctrl+Y Redo an action
Ctrl + Z Undo an action
Delete Delete the selected text, object, or slide
Esc End the slideshow
F5 Play the presentation from the start
F7 Check for spellings
Home Go back to the beginning of the slide
N or Page Down Move to the next slide while playing the slideshow
P or Page Up Return to the previous slide while playing the slideshow
Shift + F5 Play the presentation from the current slide
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